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MECH-Q License Agreement

In accordance with this Agreement, "ASVIC" incorporates ASVIC Engineering & Software (Incorporated as
Reywood Pty Ltd ACN 073 223 319). The term "Software" includes the ASVIC Software program supplied on disk
media and/or CD-Rom in this package together with the accompanying documentation and hardware lock. ASVIC
Engineering & Software is the copyright owner of the Mech-Q range of software including the contents of this
package. ASVIC confers to the User a general, non-transferable license to utilize the Software and documentation
conditional to the following information.

License Conditions

All software usage must be in accordance with the following conditions:

Each licensed software package may:

a) only be installed on one (1) computer

b) NOT in part or whole be used or copied on more than one computer at a time

c) be physically transferred from one computer to another, provided the Software is installed on only one computer
atatime

d) NOT be used in a network or multi-user system unless a multi-user version has been purchased, and then may
only be used by the number of concurrent users permitted in the license that you have purchased

Reserved Privileges & Responsibilities

The software may:

a) be copied once only for back-up purposes.

b) NOT in part or whole be modified, reverse engineered, de-compiled, disassembled, translated, copied (back up
copy excluded) or used to create derived works based products

¢) NOT be rented, disclosed, published, sold, assigned, leased, sub-licensed, marketed, transferred or used in any
other manner not expressly authorized by this Agreement

d) NOT have its proprietary notice, labels or marks removed or altered in any way

e) NOT be used for commercial or other revenue-generating purposes if the Software has been licensed or labeled
for educational use only

f) NOT be used with any computer hardware or software designed to defeat hardware copy-protection devices,
should the Software you have licensed be equipped with such protection.

All software, documentation and legitimate (back-up) copying made by the User are retained in title and copyright by
ASVIC. The User must agree to return to ASVIC, within 7 days of termination of this Agreement, all Software,
documentation and copying of the software. The software must also be erased from any storage devices. Any
unauthorized duplication (constituting copyright infringement*) or copying of the software and documentation will
constitute a failure to comply with the terms and conditions of the Agreement. Such actions will result in the
immediate termination of this license. The breach of any terms and conditions contained in the Agreement will result
in immediate termination of this license.

*Under the law, infringement of Copyright is punishable via criminal actions. Additionally civil remedies sanction the
restoration of certain damages or a consideration of profits based on the sum total of prohibited copies made.

Warranties & Liabilities

No express warranties are made by ASVIC in respect to the software. Within the confines of the law, ASVIC
disclaims any expressed or implied warranties specific to the condition and suitability of the software for a particular
role that would otherwise be reserved by law to this Agreement. ASVIC does not warrant that the operation of the
software will be uninterrupted or error-free.

In no event will ASVIC be liable for any damages whether direct, indirect, unique or resultant, including: loss of data,
lost profits, or originating in any kind from the use or inability to use the software or in respect to the software's use
in accordance with the law.

Upgrades and Updates

If this software is being licensed to you as an upgrade or update to software previously licensed to you, you must
return the software previously licensed to you, delete any copies resident on your hard-disk drive and return any
hardware locks which came with the software previously licensed to you (if any) within 7 days of the purchase of the
license to use the upgrade or update. ASVIC reserves the right to require you to show satisfactory proof that
previous copies of the software have been destroyed. If the hardware lock is not returned when requested, ASVIC
reserves the right to charge you for it.

Representations

Upon acceptance of this Agreement, the User has placed no reliance on:

a) representations put forward by the supplier or ASVIC which are not specifically detailed in this Agreement.

b) statements, representations, or details embodied in any documents including any gazettes or advertising
information produced by or on behalf of your supplier or ASVIC.

If these terms and conditions in part or whole are unacceptable to the User, the unused Software (packaging intact)
may be returned within 7 days of purchase to the supplier. Upon production of the proof of purchase, the supplier
will refund the price in full



Table of Contents

Chapter 1: Introducing Mech-Q
1.1 What is Mech-Q?
Installation & Authorization
CAD Versions Supported
Mech-Q Menu
Mech-Q General Configuration Editor
1.5.1 Mech-Q Configuration Tutorial

—_ A
AP wWON

Chapter 2: Mech-Q Piping Tutorial

2.1 Introduction
2.1.1 Single/Double Pipe CFG
2.1.2 Piping Layers Configuration
2.1.3 Piping Options
2.2  Double Line Piping Tutorial
2.2.1 User Defined Flange
2.2.2 User Defined Valve
2.3  3-D Piping Tutorial
2.4  Piping BOM Tutorial
2.4.1 BOM Configuration
2.4.2 Build BOM Table in Current Drawing
2.4.3 Send BOM Table to File
2.5 Adding / Deleting Pipe or Fittings

Chapter 3: Mech-Q HVAC Ducting Tutorial

3.1 Introduction
3.1.1 Duct Bends/Elbows CFG
3.1.2 Duct Connection CFG
3.1.3 Duct Draw Options

3.2 2D Duct Draw Tutorial

Chapter 4: Mech-Q Structural

4.1  Structural Shapes (Standard Steel Members)
4.1.1 Draw Options
4.1.2 Configuration (CFG)
4.1.3 Layers
4.1.4 Steel Member Drawing Tutorial
4.1.5 Steel Members — BOM Tutorial



4.2

Chapter 5:
5.1

Stair Drawing

4.2.1 Design CFG

4.2.2 Layers

4.2.3 Concrete Pans

4.2.4 Stair Drawing (Single Flight) Tutorial
4.2.5 Stair Stringer Detailing Tutorial

General Items
Mech-Q Grouping and Ungrouping



Chapter 1 Introducing Mech-Q

Welcome to Mech-Q add-on solutions for AutoCAD, AutoCAD LT and
CADian. Mech-Q is provided in module form, wherein each module can
be used on its own or in combination with the other Mech-Q modules.
Mech-Q combines speed and power into an intuitive, graphical interface
that makes the process of creating your drawings a pleasure and with
much ease and dependable accuracy. This will simplify the task and
reduce drawing time by automating traditionally time-intensive tasks.

This tutorial introduces some of the main features of Mech-Q and walks
you through the creation of simple a Piping, Ducting, Structural and a
Bill of Material example.

m What is Mech-Q?

Mech-Q Utilities are add-on software to automate the generation of
common parts. The program architecture takes advantage of 32-bit/64-Bit
processing, and will all versions of AutoCAD, AutoCAD LT and Bricscad,
GstarCAD, progeCAD, AviCAD and many other CAD Software.

The software will enable you to produce intelligent, two-dimensional (and
three-dimensional production models) drawings. Components drawn using
Mech-Q Piping, HVAC Ducting (& Structural Shapes) include intelligent
data that enables you to produce auto-BOM and easy identification of each
item.



m Installation & Authorization

Procedures to install Mech-Q are outlined in the Mech-Q User Manual
provided with your software. This is either supplied with the software in
printed form or on the install CD in PDF format. This tutorial assumes you
have already properly installed and configured Mech-Q using the
instructions provided in that document.

When you start a Mech-Q application that has not been authorized, a
dialog will display that prompts you to specify whether you want to run the
software in Demo mode (as an Evaluation copy for a limited number of
days), or authorize the software. The software can only be fully authorized
using the Mech-Q Authorization utility found in the Mech-Q Maintenance
menu.



m Mech-Q Menu

Mech-Q can be accessed from the standard AutoCAD/CADian drop-down
menu or through specially designed toolbars that enable quick placement
of Mech-Q components and the execution of commands. The standard set
of AutoCAD commands and menus is also available. The interface is
designed to enhance the capabilities of the base CAD software. All the
standard AutoCAD/CADian commands will be accessible in the same way
as before the addition of Mech-Q.
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m Mech-Q General Configuration Editor

The Mech-Q Configuration dialogue allows you to set the Layers, Text
Font, Height & Style, Scale and selected System Variables to be used by
all Mech-Q utilities.

When using Mech-Q for the first time, a default configuration will be used.
You may change any or all of the configuration items, as you require.

In the following section we shall describe the steps that you would normally
take to change the Mech-Q configuration.

Mech-Q Configuration BI
[ Layers ]
[ Text and Fort ]
[ Units ]
[ General ]
[ Passwond Contral ]
Figure 1.5

Main Configuration items that can be changed, include:

e Mech-Q objects layers
e Text and Text font file
e Units (Metric or English)

Changes to the Mech-Q Configuration might require the use of an
Administrative Password (please see the Mech-Q User Manual for more
information)

NOTE

Some modules (for example Piping, Ducting & Structural) use a separate layers
configuration system. When this is the case the module layer configuration overrides the
general Mech-Q CFG “Layers” settings. The layer system of these modules can be
changed within the module’s main dialogue and also from the Mech-Q CFG module.




m Mech-Q Configuration Tutorial

Start the Mech-Q Configuration Editor by selecting the Mech-Q,
Maintenance menu item — “Mech-Q CFG”

Mech-0Q [General] Layers CFG x|
LAYVERS: MHame Caolor Liretype
Componert Pats: > | [MAN > | [eovwoaos | |
Test > | [rext > |
Text-Heawy: > | TExT2 > |.
Dimenziong: B | Dt B |
Drawing Syrmbaols: > | S » |
Hidden Lines: > | [HioDEn N B > |
Center Lines: > | [cenTer > | CENTER > |
[ Eylayer [~ ByEntity  Layer name = BY EMTITY, ta draw By Entity
[~ Draw on curent layver

Cancel |

Figure 1.5.1

Task 1:
Changing the “Component Parts” layer to “Parts” Cyan and Continuous.

To Change the Mech-Q object layers — select the “Layers” tab from the
“Mech-Q Configuration” main dialogue

NOTE

The “Component Parts” layer configuration is used by many Mech-Q functions to draw
the main items on this layer. If the toggle “Draw on current layer” is switched ON then
the setting of the “Component Parts” is ignored and the current layer setting is used
instead.

To change the “Component Parts” layer specification follow these steps:

In the “Name” column, “Component Parts” row edit box enter the new layer
name “Parts”. If the “Parts” layer is already defined in the current drawing,
use the “21 tab to select the layer name “Parts” from the layer list.

Use the “# tab next in the “Color” column, then select the color “Cyan” or
color number 4.

In the “Linetype” column, edit box enter “CONTINUOUS” or use the "2 tab

to select the required linetype from the linetypes loaded in the current
drawing. If you enter a linetype in the “Linetype” edit box that is not yet
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loaded in the drawing — Mech-Q will attempt to load this linetype if the
specified linetype is defined in the ACAD.LIN file.

This procedure will now define the “Compoment Parts” layer Name =
“Parts”, Color = “Cyan” and Linetype = “CONTINUOUS”

Use the “OK” tab when ready.

Task 2:
Changing the Mech-Q Text style and the Mech-Q text size to a new value.

To Change the Mech-Q Text style or text height — select the “Text & Font”
tab from the “Mech-Q Configuration” main dialogue

Start by selecting the Text font file. If you want to specify a font file that is
normally found in the AutoCAD search path — make sure that the toggle
“Font file within the AutoCAD search path” is ON. If this is the case only
the font file name is needed and you enter the font file name in the “Text
Font File” edit box. You can also use the “#1 tab to start the file search
dialogue to help you locate the file. If “Font file within the AutoCAD search
path” is OFF then the full path for the font file must be entered in the “Text
Font File” field.

You can also use the “Bigfont” tab to append “bigfont” properties to the text
font.

The Mech-Q text size (at drawing scale = 1:1) is entered in the “Text
Height” field. Mech-Q will multiply the text size by the Mech-Q Drawing
Scale factor. Mech-Q uses the Text Height” to set the text height for all
text generated by Mech-Q.

The Mech-Q text style that will use the “Text Font File” and the “Text
Height” specified above will be created and the style name will be as listed
in the “Text Style Name” field.

Use the “OK” tab when ready.
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Chapter 2

Mech-Q Piping Tutorial

Mech-Q Piping is made up of several modules. These include:

e Pipe & Pipe Fittings, 2D and 3D

e Pipe Isometric,

e Fabricated Pipe
e Vessels

e Pumps

e Hangers and

e Other piping tools

This tutorial will look at performing some tasks using the “Pipe & Pipe

Fittings” module or orthogonal piping module.

NOTE

Many features of the Mech-Q Isometric Piping are very similar to that of the orthogonal

piping module.

Mech-Q Pipe and Pipe Fittings Utility

P
PIFE 00 = 33, 40mm Size Ciraw
|0 = 26.60mm ‘& Ef i

DN: " T Single Line
Type: |Butt welded j Do
Mateial  [CaREON STEEL(CS) [ e
Pipe wall/F ating: |3_4 SCH40 j |SCH j Layers | Diraw CFG |
BOM Remarks: |<None> j Object | Options |
[ Eisting item [Jmit from BOK)

View/Draw.. | BOM_ | Lst | Esit | Hep |
Figure 2.0

Start the Mech-Q Pipe & Fitting module from the Mech-Q drop-down menu:
Piping - “Pipe+Fittings” or from the Piping toolbar: £
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m Introduction

Mech-Q Piping enables you to customize almost any aspect of the piping
component placement process.

The Mech-Q Piping objects are constructed parametrically by executing
data from external data files. These data files contain the dimensions
required to draw the component in 3D, Double Line, or Single Line drawing
modes.

In the Mech-Q Piping front dialogue, you are able to set several
parameters which allows you to be in control of how Mech-Q draws the
piping components, the piping specification (or type) to use, the piping
material, drawing mode (3D, 2D or Single line), the drawing scale of nodes
and the layers that Mech-Q Piping will use to draw the piping components.

An attribute tag is inserted with each Mech-Q Piping components. These
tags include all the information required to draw the Bill Of Materials (BOM)
and keep track of each component. The BOM can be generated at any
time by using the “BOM” tab. The way the BOM is built is controlled by the
Piping BOM configuration (“Options” >> “BOM CFG”)

The utility can be used to draw Single line, Double line or 3D line pipe

layouts or detail. elect "Single Line", "Double Line" or "3D" radio switch as
required
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m Single/Double Pipe CFG

The pipe Draw CFG dialogue is started by using the “Draw CFG” tab —
piping front dialogue.

Draw CFG X]
Fipe size toggle

Digable size toggle

Single line fittings scale Single line {weld) nodes

[[] 5cale = Drawing scale Draw nodes Bia/lien
e ) Fixed Size

Single line draw thickness ) Scale with Fitting

Flanges line thickness: (®) Scale = DWG Scale

[] Draw nodes as line (BW only)

i

Pipe line thickness:

] 30: Minimise Dbase {solid intemals)

I 0K l [ Cancel ]

Figure 2.1.1

The main uses of this configuration are as follows:
1. Single/Double Automatic Toggle

This toggle will automatically switch between single line to double line
drawing mode and vice versa — the toggle will take place when the pipe
size is changed above or below the “Single/Double line size toggle” setting.
If for example the “Single/Double line size toggle” is set at %4” then the
piping module will change to Single Line mode if the pipe size is %" or less
and will change to Double Line mode if the pipe size is larger than %4”.

If you wish to disable the Single/Double Automatic Toggle then set the
“‘Disable size toggle” switch ON.

2. Single Line Fittings Scale

With a single line fitting scale of one (1), the piping symbols are drawn at
scale 1:1 or true scale. However, this might not be suitable in some
situations (for example: Plant Layout drawings) where the actual size of the
fittings does not matter but the fittings must be large enough to be clearly
visible. The program gives the option of either scaling the drawings with
the Mech-Q Drawing Scale or any other scale.
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3. Single Line Nodes (size)

Single line nodes can be drawn as either a filled circle or as a slanting line.
For line type nodes set the “Line Nodes” toggle ON.

The node size can be set to either of the following options:

Fixed Size, the nozzle size will not chage

Scale with Fitting, the nozzle size changes proportionally with fitting size.
Scale=Drawing Scale, nozzle size scales with the Mech-Q Drawing Scale
4. Single Line Flanges & Pipe Line Thickness.

The line thickness for flanges & pipe line change be set to the thickness of
your choice.

5. 3D Dbase Size
By ticking ON “3D: Minimise Dbase size (solid internals) — 3D piping

objects will be drawn with a solid internal, this has the effect of minimizing
the drawing database size (compared to having hollow pipe, for example).
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m Piping Layers Configuration

Mech-0Q Pipe Layers @
M ame Color Linetupe

Pipe Layer > | [PPE > | CONTINUOUS | > |
Fittings Layer > | [PPE > | CONTINUOUS > |
Insulation Layer > | msoC > eCAD_s002w | > |
Test Layer > | [TEnT > | I coremoons | > |
Centers Layer > | [CENTER > | aCab_isooaw | > |
Hidden Laver > | ["iDDEN > | B Eoapsooew] > |
Symbols Layer > | [Evm > | CONTINDOUS | > |

Options

f« BulLayer i~ BuyEntity
Prefix to Layer Mame: Mone - [7 Draw on Current Layer

Cancel

Figure 2.1.2

NOTE
The Piping utility has its own layers configuration and the layers setting in the piping
module overrides the layers setting in the general Mech-Q Configuration

Task 1:
Changing the “Pipe Layer” name to “MyPipe” Green and Continuous.

Start the piping layers configuration dialogue by selecting the “Layers” tab
— Piping front dialogue.

To change the “Pipe Layer” specification, follow these steps:

In the “Name” column, “Pipe Layer” row edit box enter the new layer name
“Parts”. If MyLayer is already defined in the current drawing, use the &
tab to select the layer name “MyLayer” from the layer list.

Use the “# tab next in the “Color” column, then select the color “Green” or
color number 3.

In the “Linetype” column, edit box enter “CONTINUOUS” or use the "2
tab to select the required linetype from the linetypes loaded in the current
drawing. If you enter a linetype in the “Linetype” edit box that is not yet
loaded in the drawing — Mech-Q will attempt to load this linetype if the
specified linetype is defined in the ACAD.LIN file.

This procedure will now define the “Pipe layer” name = “MyLayer”, Color =

“Green” and Linetype = “CONTINUOUS”. Repeat the above procedure if
you wish to change any other layer configuration.
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Task 2:
Add a layer name prefix “Steam-* to the piping layer system.

If you wish to separate pipe object using different layer systems (for
example Steam Piping on “Steam-Pipe”, “Steam-Fittings”... use the “Prefix
to Layer Name” list to add a Prefix “Steam-“ to the pipe layer system.

If the prefix “Steam-*“ does not exist in the list, use the “New” item in the list

to add the prefix “Steam-*

Mew Layerz Prefix E3
Lapers Prefix

aK I [Earieel I

Figure 2.1.2.1

This will display the “New Layer Prefix” dialogue.

If you now select the “Steam-“ prefix in the “Prefix to Layer Name” list, all
piping layers will now have the layer prefix “Steam-“ added.

17



Start the Piping/Fittings Draw Options dialogue by selecting the “Options”
tab — Piping front dialogue.

Pipe/Fittings Draw Options

Fipe Options BOM QOptions
Draw pipe wall BOM Cn
Use elbows at bends ( BOM CFG ]

[ ] ( BOM Desc. Text ]
General Options Type Specific COptions

Draw Hidden Entities
Draw Centers (SVV/Thr/PVC./Soll fitings-Only)
[ Centers follow curve {elbows) M/ Draw Glands
Draw 30/Double line IP nodes [¥]Clinclude gaskets with flanges
[ Draw Insulation I:I Dl include gaskets with flanges
Length units: mm

[ Sizes Units CFG ] C! Pipe maximum length

DI Pipe madmum length

[ Ok l ’ Cancel

Figure 2.1.3

Pipe Options

Pipe drawing options include:

“Draw pipe wall’ (2D- double pipe draw option only)

‘Use elbows at bends” With this toggle set to ON - standard piping
elbows will be automatically added at all 90° or 45° bends.

General Options

“‘Draw Centres” When ON will draw pipe & fittings center lines.

“Centres follow curve” This is applicable to elbows only. When this
toggle is ON — center lines will be drawn following the elbows curve.

“‘Draw 3D/Double line IP nodes” To have the program add a node (point)
at the common Insertion Points (IP) — set this toggle ON.

“‘Draw Insulation” If you set this toggle ON the software will also draw pipe
& fittings insulation — Insulation thickness as specified.

18



“Size Units CFG” This will allow you to set individual units display
selections and BOM units representation for each pipef/fitting type:

Sizes Selection/BOM Listing
[]Use same units as Mech-Q Units CFG

Butt welded metric. S

Socket welded metric

Threaded metric
Victaulic-Grooved metric )

Cast Iron, Flanged metric Butt weld=d

Ductile Iron, Fig (AMNSI) metric
Ductile Iron, Fig (ALLS) metric

Ductile Iron, Grooved metric (®) Metric
Ductile Iron, MAC Joirt metric
Soil Pipe (Mo Hub) metric ) English
Stainless (O0)Tubelnd)  metric
Sanitary Fittings metric
Tubing metric l Replace
PYC-L metric ¥

[ QK ] [ Cancel ]

Figure 2.1.3.1

For example, you can select to display some pipef/fittings type in different
units than that set by the general Mech-Q Units selection.

First you need to set the toggle: “Use same units as Mech-Q Units CFG”
OFF — Then select the pipe/fitting type you want to change (for example:
“Butt Welded” — and use the “Edit” button to change to Metric or English
units as you require — Use the “Replace” button to set this units selection.

BOM Options

“BOM On” toggle — Only turn BOM toggle off if the Bill of materials (BOM)
is not required. Items drawn while the “BOM On” toggle is off will not
include BOM data attributes.

NOTE

The “BOM CFG” tab will start the Piping BOM CFG dialogue

(See ltem 2.4.1) and “BOM Desc. Text” This starts the Piping BOM Descriptions editor
(Please refer to the Mech-Q Users Manual for details on how to use the Piping BOM
Descriptions editor).
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Type Specific Options

General drawing options include:

‘Draw Hidden Layer Entities...” This is applicable to Socket welded,
Threaded, Soil Piping and PVC fittings only. If this switch is set ON,
hidden entities, for example the PVC hub bore, are not drawn.

“M/J Draw Glands” This is applicable for Mechanical Joint pipe/fittings
only. When ON, Mech-Q will draw pipe & fittings M/J Glands.

“Cl Include Gaskets with Flanges” This is applicable for Cast Iron
pipe/fittings only. When this toggle is ON — Mech-Q will draw the gaskets
between each flange pair.

‘DI Include Gaskets with Flanges” This is applicable for Ductile Iron
pipe/fittings only. When this toggle is ON — Mech-Q will draw the gaskets
between each flange pair.

“Cl Maximum Pipe Length” This is applicable for Cast Iron pipef/fittings
only. When drawing straight Cast Iron pipe - Mech-Q will automatically
draw a flange pair at each length of pipe equal to the set maximum length.
“DI Maximum Pipe Length” This is applicable for Ductile Iron pipe/fittings
only. When drawing straight Ductile Iron pipe - Mech-Q will automatically
draw a flange pair at each length of pipe equal to the set maximum length.

20



m Double Line Piping Tutorial

NOTE

In this tutorial we will draw a simple piping job in double-line format, however the steps
required to draw the same piping job in single line format or 3D format will be very
similar...

Figure 2.2.0

The aim of this tutorial is to build-up the above pipe drawing using the

Mech-Q Pipe & Fittings module. The tags (E=fl) shown in the above image
are not part of the drawing exercise, however they are aids added in this
tutorial to the drawing to help us with explaining the steps involved.

We have selected to draw our piping job using Metric units, however the
steps to draw the same job using English (imperial or inch) units will be
identical. To use the English units system — use the Mech-Q CFG and
change the “Units” to English.

Start the Mech-Q Pipe and Fittings module.
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Settings/Options

Type
Select the pipef/fitting type from the “Type” list. For this tutorial we will
select “Butt welded”

Material

When you select the pipe/fitting “Type” — Butt Welded” the Material is auto-
set to “Carbon Steel” if another material is required — select the required
material from the “Material” list.

Note: If the material that you require is not listed in the “Material” list select
the “Add New” item from the “Material” list and add the new material that
you require

Draw Type
From the “Draw” box select “Double Line”

From the “Size” list select 50 mm

From “Wall/Class” list select “STD” and “3.9 STD” wall thickness.

Options
Use the “Options” button to start the “Pipe/Fittings Draw Options” dialogue:

Set the “Draw pipe wall” toggle ON. The pipe wall will be drawn on the
“hidden” layer.

“‘Bends: Use elbows” toggle ON. When this toggle is ON, Mech-Q will
auto-insert a standard 90° or 45° as you select pipe definition points.

[If you are running small bore pipe or tube and you desire to add a pipe bend in
lieu of standard elbows — set the “Bends: Use elbows” toggle — OFF]

“BOM On’” toggle ON: BOM data will be appended to the pipe/fittings
drawn.

“‘Draw Centres” toggle ON: Pipe & fittings centre lines will be drawn.

“Insulation” toggle OFF: No insulation will be drawn.
[If insulation is required set the toggle ON and enter the insulation thickness].

Use the “OK” button to exit the “Pipe/Fittings Draw Options” dialogue
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Drawing the Pipe Spool

In the following paragraphs we will outline the recommended steps for
creating the pipe spool drawing as per Fig 2.2.0

For this exercise we recommend that you select the settings/options as
suggested above.

In some cases it will be appropriate to draw the pipe spool starting at tag
“A” then add the various pipe/fittings in sequence, finishing at tag “S”.
However, in many cases, the location of some of the fittings (Tees, bend...)
is critical to the design and for achieving the correct location of the critical
fittings we suggest that the following method be used.

Start by drawing the spool centreline (using normal AutoCAD commands,

Lines, Polylines...) and at the location of the critical fittings — add a branch
centreline or a “dummy” node (see Fig 2.2.1).

_____ [ -

_

For this exercise, the location of the branch tee, flanges and valve are
critical to the design — we have therefore located and marked their location
on the pipe spool diagram (Fig 2.2.1)

___________ ><____

Figure 2.2.1

The next step will be to insert the fittings at the critical locations.

As we already have the pipeline centreline drawn, the “Add Centres” toggle
in the Options box should be turned OFF.

NOTE

To start drawing a pipe or pipe fittings either select the required pipef/fitting icon image
and then use the “Draw/View” tab, or simply double click on the relevant icon image.
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TEE (B-C tags)

Select the tees icon image (3™ icon, top row) in the Piping main dialogue
then use the “Draw/View” tab. The Tees “Make Selection” dialogue will be
displayed. This dialogue will give you several options of views that you can
draw of the selected tee and also the option of selecting a reducer tee.

The tee in our exercise is a 50 — 32NB (2" — 1 74”) reducing tee. Set the
“‘Reducing Tee” toggle ON and select 50 — 32NB (or 2" — 1 ¥4” for English
units) from the reduced size list.

We need to place the tee at the branch insertion point (midway tab B and
tag C) — The most appropriate view is represented by the top left icon
image in the Tee — “Make Selection” dialogue. When you pick this icon with
your pointing device the tee drawing process will begin.

NOTE

Image icons with multiple insertion marks “X” are sensitive to the pick position. In these
cases make sure that you pick the image — close to the “X” insertion mark that best suites
your insertion point requirement.

To start drawing: select the top left icon image — close to the Centres
insertion “X” IP. (Close to the middle of the icon image).

Command: Pick install point/Fitting/Undo last/eXit(<point>/F/U/X):

Point:  Pick insertion point (IP)— program will suggest the most
appropriate point following the previous pipef/fitting. Choose the
selected IP if appropriate or select a new point as required.

Fitting: Will display the pipe/fitting selection dialogue to let you select
another pipe or fitting.

Undo: Will UNDO the last pipe or fitting inserted in the drawing.

eXit: Exits the pipef/fittings insertion and terminate the program.

Mark Will mark the suggested IP with a “gost” X mark.

IP:

Pick the required insertion point (midway tab B and tag C)

Command: Roll (Yes/No)<N>:

Roll: If you answer “Y” the program will respond with Roll In/Out(l/O)<O>:
If you answer “O” the roll will outwards if you answer “I” the roll will be

inwards. Roll will be 45°

Select “N” (no) for roll.

The selected tee will be drawn at rotation = 0.0

24




The Rotation dialogue will now be displayed:

50 deg

Cither Angle

Figure 2.2.1.1

Select the fitting rotation= 0.0deg (no rotation)

NOTE

Selecting the “Other Angle” button will start the rotation command which
works exactly the same as the normal AutoCAD rotate command.

Double FLANGES (D-E-F tags)

Select the flanges icon image (4" icon, bottom row) in the Piping main
dialogue then use the “Draw/View” tab. The flanges “Make Selection”
dialogue will be displayed.

Make selection @

Options

v Draw baolt centers
v Draw bolt holes
Iv Diraw hidden lines
-

v Baized face

o Seat;

-

[~ Gasket I:I

Fasteners
{* Buolts " Studs

[ Grodp fazteners in zets

Uszer Defined Flanges

—
oeen |
Lo |

Tupe: m I—_| Cancel

Pick image tile to start draw.

| '

Draw Double Flange

Figure 2.2.2

The current exercise requires a set of double welding neck flanges at tag
“E” (marked with a node x — Fig 2.2.1)
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Select “Welding Neck” from the flanges “Type” list. Set the other options
as follows:

“‘Draw bolt Centres” toggle ON: Centrelines will be drawn at he bolt holes
(toggle OFF to suppress drawing bolt holes Centres).

“‘Draw bolt holes” toggle ON: Bolt holes will be drawn on the Hidden layer.
“‘Draw hidden lines” toggle ON: Allows hidden lines to be shown (toggle
OFF to suppress drawing hidden lines).

“‘Draw bevels” toggle ON: The pipe end of the flange will be drawn beveled
(weld prep.).

“‘Raised face” toggle ON: To draw the flanges with a raised face.

“Slip On” toggle: OFF. ON will force the flanges to be drawn slip-on type
(when appropriate).

‘Draw as PLATE flange” toggle OFF. ON will draw the flange in its
simplest form similar to the “PLATE flange” without extra detail such as
the neck. The type of flange selected however will still be included in the
BOM.

“Gasket” toggle ON: Gaskets will be added to the BOM Set the gasket
allowance gap as required.

Fasteners: select “Bolts” or “Studs” In the BOM the fasteners can be
added as individual items (for example 6 Bolts....) or as a fastener set (for
example 1 set Bolts.... 1 set includes the number of fasteners required for
the flange drawn).

To start drawing a double flange: select the “Draw Double Flange” tab.

Command:
Pick install point/Fitting/Undo last/eXit/Mark IP(<point>/F/U/X/IM)<x,y>:

Point:  Pick insertion point (IP)— program will suggest the most appropriate
point following the previous pipeffitting. Choose the selected IP if
appropriate or select a new point as required.

Fitting: Will display the pipeffitting selection dialogue to let you select another

pipe or fitting.
Undo:  Will UNDO the last pipe or fitting inserted in the drawing.
eXit: Exits the pipe/ffittings insertion and terminate the program.
Mark Will mark the suggested IP with a “gost” X mark

IP:

Select the node point (Fig 2.2.1) — flange location (tag “E” Fig 2.2.1)
The first flange will now be drawn at rotation 0.0.

The Rotation dialogue will now be displayed (same as Figure 2.2.1.1):
Select the fitting rotation= 0.0deg (no rotation)

Command: Move Flange to Face IP<Y>:

To select: “N” (no) option.
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If you wish to move the double flange by a distance equal to one flange
thickness (for example if the flange set is being inserted at the end face of
a fitting) — Select the “Y” (yes) option.

NOTE

The program adds a fasteners invisible attribute block with the fasteners data that
will be added to the BOM. The program will also add a Gasket invisible attribute
block that will be added to the BOM data.

Gate VALVE (P-Q tags)

Note that the gate valve size is DN 32 (or 1 V2 NB) — Set the pipef/fitting
“Size” to DN 32 (or 1 V2 NB).

Select the valve icon image (5" icon, bottom row) in the Piping main
dialogue then use the “Draw/View” tab. The valves “Make Selection”
dialogue will be displayed.

Make selection @

Qptions

[JEnd View

[[]No Flanges (Eg: BW)

Raized Face

Draw Handle
Gasket

] Show Gap Add BOM

BOM Spec: |

User Defined Valves

Walve o/a Length:

Type: | Gate Valve w

Cancel

Figure 2.2.6

Select “Gate Valve” from the “Type” list.

Options

“‘End View” toggle OFF: “Valve” will be drawn with view as shown in the
image icons. (If toggle is set ON valve end view will be drawn.

‘Butt Welded...” toggle OFF: (if set ON a welded type valve will be drawn
— No flanges).

“‘Raised face” toggle ON: To draw the flanges with a raised face.

“‘Draw Handle” toggle ON: To Draw valve handles. (OFF to suppress
drawing the valve operating handles).
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“Valve o/a length” Mech-Q will suggest a valve over-all length. If you wish
to use a different value for the over-all length — please enter the new value
here.

“Use Gasket” toggle OFF: Gaskets will not be added to the BOM Gaskets
will added with the Flanges insertion. Set the Gasket toggle ON - to add
gaskets to the BOM table.

NOTE

“User Defined Valves” — Not used in this exercise (See section 2.2.2)

To start drawing gate valve select the bottom gate valve icon so that the
mid-point insertion point will be used to locate the valve.

Command: Pick install point/Fitting/Undo last/eXit(<point>/F/U/X)<x,y>:

Point:  Pick insertion point (IP)— program will suggest the most
appropriate point following the previous pipef/fitting. Choose the
selected IP if appropriate or select a new point as required.

Fitting: Will display the pipeffitting selection dialogue to let you select
another pipe or fitting.

Undo: Will UNDO the last pipe or fitting inserted in the drawing.

eXit: Exits the pipe/fittings insertion and terminate the program.

Select the node point (Fig 2.2.1) -gate valve location (tag “P-Q” Fig 2.2.1)

Command: Point direction/Angle(<point>/A):

Point Pick a point in the required valve direction to indicate valve

Direction:

Angle: If the valve rotation angle is known — select this option to
specify the

valve rotation

Select the valve rotation = “0.0deg” for this exercise

The valve will now be drawn at the rotation specified (0.0).

Command: Handle Roll/Ang (A to specify angle)<0.0>:

Handle This gives you a quick way to specify the valve handle location in
Roll: relation to the valve:
If you point in the general direction of valve + 90° the valve
handle will be drawn “up”
If you point in the general direction of valve - 90° the valve
handle will be drawn “down”
If you point in the general direction of valve the valve handle will
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be drawn perpendicular to the sheet view
Ang: Specify the valve handle roll if known.

Point in the direction “up” (valve direction +90°) — Valve handle will be
drawn in the “up” direction.

For this type of valve, we need to add a “Plate” type flange to either end of
the valve.

FLANGE (N &R tags)

Follow the same procedure as for adding the Double Flange above to start
the flanges — “Make Selection” dialogue and set the options/settings as
before — except this time select a “Flat” type flange and to draw the flanges
at either end of the gate valve — use the 2" icon image from the top to start
drawing each flange. This will draw the flange using the flange “face”
insertion point.

Make sure that fasteners & Gaskets are added to the flange at each end.

REDUCER (K-L tags)

The exact location for the “Reducer” at tag K-L is not critical to the present design and we
will locate it approximately halve way between the gate valve and the lower elbow (J-K
tags)

Select the reducer icon image (3" icon, bottom row) in the Piping main
dialogue then use the “Draw/View” tab. The valves “Make Selection”
dialogue will be displayed.

Make zelection E

Sie TR <]
% Feducer

Rall INone "I
" Espansion [~ FElat on top

Fick image tile to start draw.

Cancel |

Figure 2.2.5

Reducer/Expansion: Select “Reducer’.

Size: Select “50-32” (or 2" — 1 '4”)
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Flat on top: Set to OFF, This is only relevant to eccentric reducers (If set
ON the reducer “flat” side will be drawn on “top”).

Roll: No roll is required — Select “None”

NOTE

Roll is the rotation of the item in the “Z” plane — about the object centreline

To start drawing the eccentric reducer select the 2" icon image from left.

Command:
Pick install point/Fitting/Undo last/eXit/Mark IP(<point>/F/U/XIM)<x,y>:

Point:  Pick insertion point (IP)— program will suggest the most
appropriate point following the previous pipef/fitting. Choose the
selected IP if appropriate or select a new point as required.

Fitting: Will display the pipeffitting selection dialogue to let you select
another pipe or fitting.

Undo: Will UNDO the last pipe or fitting inserted in the drawing.

eXit: Exits the pipe/fittings insertion and terminate the program.

Mark Will mark the suggested IP with a “gost” X mark

IP:

Select the point (reducer large end) where the reducer is required,
approximately mid-way between the gate valve and the lower elbow.

Command: Point direction/Angle(<point>/A):

Point Pick a point in the downstream direction to indicate fitting

Direction: direction.

Angle: If the rotation angle is known — select “A” to specify the
rotation.

Command: Draw eccentric reducer concentric shape - plan view(Y/N)<N>:

This option lets you draw the eccentric reducer in “plan” view with a
concentric shape. Select the No (N) option.

The reducer will now be drawn at the rotation specified (180.0).

NOTE

When using an eccentric type reducer, the pipe line centreline upstream is not
In-line with the centreline downstream of the reducer. To establish the correct
placing of the downstream centreline, we suggest that you first draw this centreline
in-line with the upstream centreline and then after you draw the reducer move the
downstream center and other downstream fittings drawn to the correct location.

All that now remains to finish the pipe spool (Fig 2.2.1) is to add the pipes
and elbows. The program can add elbows automatically as you go round
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90° corners (or 45° bends). To set the program for this option, set the
toggle “Elbows Use bends” ON (main piping dialogue).

“‘A’- PIPE

After your desired options have been set, make sure the “Pipe” image icon
is highlighted and you may now select “View/Draw”. A dialog box will
appear to help you define the properties of the “Pipe”. These include the
following:

Start/End
Select either “Bevel” or “Square” to draw a beveled edge or straight edge
on either the start and/or the end of the “Pipe”.

Direction arrow
You may alter the direction of the arrow drawn along the center of the
pipeline. Select “None” to continue drawing a normal centreline.

Welding gap allowance
If a welding gap is not required then set the welding gap allowance to “0.0”.

Select the square edged “Pipe” image icon and begin drawing.

You can always return to the “Pipe fittings” dialog box by typing “F” in the
command window at the bottom of the screen.

Pick an install point and an end point; you can enter the coordinates within
the command window or pick points directly on the worksheet. <Enter>.

The “Pipe fittings” dialog box will appear to prompt you for the next piping
component. Select the “Tee” component in the top row-middle.

NOTE

You can always attach piping components at any time from selecting the “Mech-Q Pipe
and Pipe Fittings Utility”. The “Pipe fittings” dialog box is just simply a convenient and
quick way of attaching components.

“C’- PIPE

By now you should have a general idea of the process involved in
constructing the piping system.

Repeat the processes outlined above to construct the next “Pipe”
component.
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E User Defined Flange

Select the “New” tab — or <Add New> from the drop down menu to create
a “User Defined Flange”. A dialog box will appear that allows you to
customize all the flange properties such as the “Type”, “Thickness”, “Hub
Diameter”, “Neck diameter”, “No. of Holes” and other Flange properties.
Select the “Save Design” button to keep the data for use later on.

User Flange Data
Save Mame: |32_Flange |
Siiee (L ZHE]: |32 [11/4] |
Type: IF'Iate j
Designation: [FLATE FLANGE(SP) |
Flange OD: |11?.48 |
Flange Thickness: |1 5.8 |
Length Tru Hub: |2D.? |
Hub Diameter: |58.8 |
Meck diameter: [42.2 |
Raized face Diam: |53.5 |
Raized face height: |E.EI |
Holes PCD: EEE |
Huoles Diameter: |'| 58 |
Bolt/Stud Size: [M15 |
Ma. of Hales m
Size in "mm"

Save Degign |

Figure 2.2.3

Select the top Flange image icon to draw and pick installation point.

You may be prompted to “Add Gasket” and/or “Add Fasteners”, Type “Y” in
the command window if you choose to do so. If you do not want to “Add
Gasket” or “Add Fasteners” then type “N”.

Rotate flange to the desired position and <Enter>.

Repeat the same processes outlined above to attach the second flange.

“F-L”- Pipe drawing using bends/elbows

Sketch the next “Pipe” component by drawing horizontally as previously
done in sections “A” and “C”. However this time, select your installation
point, select your endpoint and then continue vertically downwards to point

“H” and <Enter>.

Mech-Q will automatically insert a standard 90° elbow following the
direction of sketch as previously set.
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You also have the option of selecting the elbow manually from the “Mech-Q
Pipe and Pipe Fittings Utility”. This leads to more various elbow options.

Make selection E

[ Reducing

[ Plan View: Lange size In/Out

[] Radius Bend l:l
[ Short Radius Angle: [:]
Select image tile at required |P mark.

Figure 2.2.4

Make your selection from the dialog box. If you choose to select the
standard curve shaped elbow, you will be prompted for various options in
the command window.

NOTE

The elbows dialogue allows you to select a reducing elbow (by selecting the “Reducing”
toggle — then selecting the reducing size from the list.

You can also set the bend radius to any radius you wish.

Other options include a bend angle other than 90deg — This represents a CUT elbow.

For this tutorial the straight 90deg standard elbow is drawn

Command: Pick install point/Fitting/Undo last/eXit(<point>/F/U/X):
Pick your installation point. You will be prompted for a “roll angle”. This

defines the angle of placement in the 3D plane — this should be 0.0 for this
tutorial.

Continue drawing to point “L”.
A “Valve fitting” must be connected to a “Flange”, you must first attach a

“Flange” to the last “Pipe” component.

Select the “Flange” once again from the “Pipe fittings” dialog box and
connect a “Flange” to the “Pipe” component.

Select the “Valve” component from the “Pipe fittings” dialog box. The
“Valve Editing” dialog will appear.
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m User Defined Valve

Select “New” tab — or <Add New> from the drop down menu to create a
“User Defined Valve”. A dialog box will appear that allows you to customize
all the valve properties such as the “Face to face height”, “Thickness”,
“‘Handle height”, and other Valve properties. Select the symbol to use for
the “User defined valve”. Select the “Save Design” button to keep the data
for use later on.

Uszer Yalve Data
Save Name: |32_Valve |
iz [HYHEN |32 114 |
Designation:; |CW' RS |
Face to face height: |'I 17.48 |
Flange 0D or OD): [117.48 |
Flange Thickness: |'I 53 |
Herdle heih: [117.48 |
Symbol Counter weight valve j [—-.::_l_:.-—T

Size in "mm"

Save Design |

Figure 2.2.8

Select the Gate Valve image icon to draw and pick installation point.
You may be prompted for “Handle Roll/Ang”. Enter the angle or move
cursor to the direction that you would like the Handle drawn.

Continue drawing to point “S” and this concludes the double line pipe
tutorial. Save your file for use in later tutorials.
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m 3-D Piping Tutorial

NOTE

In this tutorial we will draw a simple piping job in 3-D format.

Use this link for a Macromedia version of this tutorial:
http://www.asvic.com.au/files/mechqdemo3d.htm

FA

A = = oa O A
— }@ —

Mech-Q Pipe & Fittings module. The tags (E8) shown in the above image
are not part of the drawing exercise, however they are aids added to the

drawing to help us with explaining the steps involved.

We have selected to draw our piping job using metric units, however the
steps to draw the same job using English (imperial or inch) units will be
identical. To use the English units system — use the Mech-Q CFG and
change the “Units” to English.

Start the Mech-Q Pipe and Fittings module.

Settings/Options

Type

Select the pipe/fitting type from the “Type” list. For this tutorial we will
select “Butt welded”

Material
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When you select the pipe/fitting “Type” — Butt Welded” the Material is auto-
set to “Carbon Steel” if another material is required — select the required
material from the “Material” list.

Note: If the material that you require is not listed in the “Material” list select the “Add New”
item from the “Material” list and add the new material that you require

Draw Type
From the “Draw” box select “3D”

Pipe Spec
From “Wall/Class” list select “STD” and “3.9 STD” wall thickness.

Options

“‘Bends: Use elbows” toggle ON. When this toggle is ON, Mech-Q will
auto-insert a standard 90° or 45° as you select pipe definition points. If you
are running small bore pipe or tube and you desire to add a pipe bend in
lieu of standard elbows — set the “Bends: Use elbows” toggle — OFF

‘BOM On” toggle ON: BOM data will be appended to the pipeffittings
drawn.

“Insulation” toggle OFF: No insulation will be drawn. If insulation is
required set the toggle ON and enter the insulation thickness.

Drawing the Pipe Spool

In the following paragraphs we will outline the recommended steps for
creating the pipe spool drawing as per Fig 2.3.1

For this exercise we recommend that you select the settings/options as
suggested above.

In some cases it will be appropriate to draw the pipe spool starting at tag
“A” then add the various pipef/fittings in sequence, finishing at tag “S”.
However, in many cases, the location of some of the fittings (Tees, bend...)
is critical to the design and for achieving the correct location of the critical
fittings we suggest that the following method be used.

Start by drawing the spool centreline (using normal AutoCAD commands)

and at the location of the critical fittings — add a branch centreline or a
“‘dummy” node (see Fig 2.3.2).
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Figure 2.3.1

The next step will be to insert the fittings at the critical locations.

For this exercise, the location of the branch tee, flanges and valve are
critical to the design — we have therefore located and marked their location
on the pipe spool diagram (Fig 2.3.1)

NOTE

To start drawing a pipe or pipe fittings either select the required pipe/fitting icon image
and then use the “Draw/View” tab, or simply double click on the relevant icon image.
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TEE (B-C tags)

Select the tees icon image (3™ icon, top row) in the Piping main dialogue
then use the “Draw/View” tab. The Tees “Make Selection” dialogue will be
displayed.

The tee in our exercise is a 50 — 32NB (2” — 1 4”) reducing tee. Set the
“‘Reducing Tee” toggle ON and select 50 — 32NB (or 2" — 1 V4” for English
units) from the reduced size list.

We need to place the tee at the branch insertion point (midway tab B and
tag C) — Select the icon at a point close to the middle of the icon image —
this will force the software to insert the tee at the midway point. When you
pick this icon with your pointing device the tee drawing process will begin.

Command: Pick install point/Fitting/Undo last/exit/Mark(<point>/F/U/XIM):

Point:  Pick insertion point (IP)— program will suggest the most
appropriate point following the previous pipef/fitting. Choose the
selected IP if appropriate or select a new point as required.

Fitting: Will display the pipeffitting selection dialogue to let you select
another pipe or fitting.

Undo: Will UNDO the last pipe or fitting inserted in the drawing.

eXit: Exits the pipe/fittings insertion and terminate the program.

Mark Will mark the suggested IP with a “gost” X mark.

IP:

Pick the required insertion point (midway tab B and tag C)
Command: Point direction:

Select a point to point the downstream (main) direction
Command: Branch direction:

Select a point to point the tee branching direction
Command: Roll (0.0):

Enter the Roll in degree angle (or accept) the 0.0 for No Roll.

The selected tee will be drawn at rotation = 0.0
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Double FLANGES (D-E-F tags)

Select the flanges icon image (4" icon, bottom row) in the Piping main
dialogue then use the “Draw/View” tab. The flanges “Make Selection”
dialogue will be displayed.

Make selection @

Pick image Options

Diraw bevels Raized face

[] Draw as PLATE flange

Gasket

Thickness

[ show Gap Compressed:
[¥] Add BOM BOM Thk:
Fasteners

(®) Bolts O Studs ) None

[ Draw Double Flange ] []Group fasteners in sets

User Defined Flanges

Pipespec: |35 5§TD v

Type: Welding Neck | »

Pick image tile to start draw.
Figure 2.3.2

The current exercise requires a set of double welding neck flanges at tag
“E” (marked with a node x — Fig 2.3.1)

Select “Welding Neck” from the flanges “Type” list. Set the other options
as follows:

“‘Draw bevels” toggle ON: The pipe end of the flange will be drawn
beveled (weld prep.).

“Raised face” toggle ON: To draw the flanges with a raised face.

‘Draw as PLATE flange” toggle OFF. ON will draw the flange in its
simplest form similar to the “PLATE flange” without extra detail such as the
neck. The type of flange selected however will still be included in the BOM.
“Gasket” toggle ON: Gaskets will be added to the BOM Set the gasket
allowance gap as required.

Fasteners: select “Bolts” or “Studs” In the BOM the fasteners can be
added as individual items (for example 6 Bolts....) or as a fastener set (for
example 1 set Bolts.... 1 set includes the number of fasteners required for
the flange drawn).

To start drawing a double flange: select the “Draw Double Flange” tab.

Command:
Pick install point/Fitting/Undo last/eXit/Mark IP(<point>/F/U/X/IM)<x,y>:
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Point:  Pick insertion point (IP)— program will suggest the most
appropriate point following the previous pipef/fitting. Choose the
selected IP if appropriate or select a new point as required.

Fitting: Will display the pipe/fitting selection dialogue to let you select
another pipe or fitting.

Undo: Will UNDO the last pipe or fitting inserted in the drawing.

eXit: Exits the pipe/fittings insertion and terminate the program.

Mark Will mark the suggested IP with a “gost” X mark

IP:

Select the node point (Fig 2.3.2) — flange location (tag “E” Fig 2.3.1)
Command: Point direction:

Select a point to point the general pipeline direction

Command: Bolt holes offset(N for no offset)<45>:

Accept the suggested offset rotation.

The selected flange set will be drawn.

NOTE

The program adds a fasteners invisible attribute block with the fasteners data that
will be added to the BOM. The program will also add a Gasket invisible attribute
block that will be added to the BOM data.

Gate VALVE (P-Q tags)

Note that the gate valve size is DN 32 (or 1 V2 NB) — Set the pipef/fitting
“Size” to DN 32 (or 1 4 NB).

Select the valve icon image (5" icon, bottom row) in the Piping main
dialogue then use the “Draw/View” tab. The valves “Make Selection”
dialogue will be displayed.

Make selection E

Options

[1No Flanges (Eg: BW)

Raised Face

Draw Handle
Gasket

[15how Gap Add BOM

User Defined Valves

wec/a Langt
Toe | Gate Val v
Cancel |
Figure 2.3.6
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Select “Gate Valve” from the “Type” list.

Options

‘Butt Welded...” toggle OFF: (if set ON a welded type valve will be drawn
— No flanges).

“‘Raised face” toggle ON: To draw the flanges with a raised face.

‘Draw Handle” toggle ON: To Draw valve handles. (OFF to suppress
drawing the valve operating handles).

“Use Gasket” toggle OFF: Gaskets will not be added to the BOM Gaskets
will added with the Flanges insertion. Set the Gasket toggle ON - to add
gaskets to the BOM table.

NOTE

“User Defined Valves” — Not used in this exercise (See section 2.3.2)

To start drawing gate valve select the bottom gate valve icon so that the
mid-point insertion point will be used to locate the valve.

Command: Pick install point/Fitting/Undo last/eXit(<point>/F/U/X)<x,y>:

Point:  Pick insertion point (IP)— program will suggest the most
appropriate point following the previous pipef/fitting. Choose the
selected IP if appropriate or select a new point as required.

Fitting: Will display the pipeffitting selection dialogue to let you select
another pipe or fitting.

Undo: Will UNDO the last pipe or fitting inserted in the drawing.

eXit: Exits the pipe/fittings insertion and terminate the program.

Select the node point (Fig 2.3.2) -gate valve location (tag “P-Q” Fig 2.3.1)
Command: Point direction:

Select a point to point the general pipeline direction

Command: Axial Roll (0.0):

Enter the Axial Roll in degree angle (or accept) the 0.0 f or No Roll.

The selected valve will be drawn.

FLANGE (N & R tags)

Follow the same procedure as for adding the Double Flange above to start
the flanges — “Make Selection” dialogue and set the options/settings as
before — except this time select a “Plate” type flange and to draw the
flanges at either end of the gate valve — use the 2" icon image from the
top to start drawing each flange. This will draw the flange using the flange
“face” insertion point.

41



Make sure that fasteners & Gaskets are added to the flange at each end.

REDUCER (K-L tags)

The exact location for the “Reducer” at tag K-L is not critical to the present
design and we will locate it approximately halve way between the gate
valve and the lower elbow (J-K tags)

Select the reducer icon image (3™ icon, bottom row) in the Piping main
dialogue then use the “Draw/View” tab. The valves “Make Selection”
dialogue will be displayed.

Make selection E

Size
¥ Reducer

Rioll INu:une "I
" Espansion I~ Elat on tap

Pick image tile to start draw.

Cancel |

Figure 2.3.5

Reducer/Expansion: Select “Reducer’.
Size: Select “50-32” (or 2" — 1 '4")

Flat on top: Set to OFF, This is only relevant to eccentric reducers (If set
ON the reducer “flat” side will be drawn on “top”).

Roll: No roll is required — Select “None”

NOTE

Roll is the rotation of the item in the “Z” plane — about the object centreline

To start drawing the eccentric reducer select the 2nd icon image from left.

Command:
Pick install point/Fitting/Undo last/eXit/Mark IP(<point>/F/U/X/IM)<x,y>:

Point: Pick insertion point (IP)— program will suggest the most
appropriate point following the previous pipef/fitting. Choose
the selected IP if appropriate or select a new point as required.

Fitting: Will display the pipe/fitting selection dialogue to let you select
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another pipe or fitting.
Undo: Will UNDO the last pipe or fitting inserted in the drawing.
eXit: Exits the pipeffittings insertion and terminate the program.
Mark IP:  Will mark the suggested IP with a “gost” X mark

Select the point (reducer large end) where the reducer is required,
approximately mid-way between the gate valve and the lower elbow.

Command: Point direction:
Select a point to point the general pipeline direction
The selected reducer will be drawn.

NOTE

When using an eccentric type reducer, the pipe line centreline upstream is not
In-line with the centreline downstream of the reducer. To establish the correct
placing of the downstream centreline, we suggest that you first draw this centreline
in-line with the upstream centreline and then after you draw the reducer move the
downstream center and other downstream fittings drawn to the correct location.

All that now remains to finish the pipe spool (Fig 2.3.1) is to add the pipes
and elbows. The program can add elbows automatically as you go round
90° corners (or 45° bends). To set the program for this option, set the
toggle “Elbows Use bends” ON (main piping dialogue).

“A’- PIPE
After your desired options have been set, make sure the “Pipe” image icon
is highlighted and you may now select “View/Draw”.

Pick an install point and an end point; you can enter the coordinates within
the command window or pick points directly on the worksheet. <Enter>.

“C”- PIPE

By now you should have a general idea of the process involved in
constructing the piping system.

Repeat the processes outlined above to construct the next “Pipe”
component.

43




m Piping BOM Tutorial

We will look at three tasks relevant to Piping Bill Of Materials (BOM)
e 2.4.1 BOM Configuration
e 2.4.2 Build BOM Table in current Drawing
e 2.4.3 Send BOM Table to File.

@ BOM Configuration

The Piping BOM Configuration is set in two parts.

BOM Configuration Part 1

NOTE

The Piping BOM Configuration (Part 1) MUST be set BEFORE any piping
objects are added to your current drawing.

From the Piping front (main) dialogue select the “Options” tab, then the
“BOM CFG” tab — The will start the “Piping BOM CFG Dialogue”

Foe——— ol
. Fields CFG Options e
[] Ask to add BOM item Leader
[] Add BOM Balioons
[ Urigue tem-each pips
[¥] Add Type to Description
[ Full Material description

Fipe Desc. Fomat: PIPE 0.0 OD Xwow Wall [
[] BOM Stock Codes ON

Piping/BOM blocks found: Some options disabled
Apply new CFG on Mew Drawings ONLY

[ OK ] [ Cancel J

Figure 2.4.1.1
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Fields CFG The fields that you tick ON will be included in the Piping BOM
Table.

Options

“Ask to add BOM Items” When this toggle is set ON — the software will not
automatically add BOM data to the object drawn — but will always prompt
you to add or not add the BOM data.

“‘Add BOM Balloons” If you wish to have BOM balloons added to point to
the pipe/fittings when inserting the BOM — set this toggle ON.

“‘Unique item-each pipe” When the program starts to compile the BOM
table — pipe items of the same specification and size can be grouped
together (when the toggle “Unique item-each pipe” is ON or they can se set
individual item numbers if this toggle is set OFF.

“Full material description” When you set this toggle ON — The BOM table
will add full material description in the “Material” field. When the toggle is
set OFF — abbreviations will be used.

You can specify the “Pipe Description Format” by selection the format
that you prefer from the options provided.

Then you set the “BOM Stock Codes ON” toggle ON — the software will
add Stock-Codes for each Pipe/Fitting object. Stock Codes can be any
valid ID number — according to your industry or organization requirements.
The software will prompt you for the stock code of each item inserted.
However once a code is entered for a given item and size — the code is
stored on file on your computer or network drive as you specify. Use the

_=ltab to specify the Stock Codes file location.
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BOM Configuration Part 2

This configuration is set at the point when the BOM table drawing process
is started.

NOTE

The Piping BOM Configuration (Part 2) should be set BEFORE any Piping BOM items
are added to your current drawing. However items, such as:

e BOM Table build direction
o Install Corner
e Selection type
e BOM Table sent to Drawing or File...

Can be changed at any time (even when BOM items are already in the current drawing).

To start the BOM Configuration Part 2 — Select the “BOM” tab from the
piping front (main) dialogue. This starts the Mech-Q BOM Configuration
dialogue.

Mech-0 BOM Configuration
BOM table row height: - BOM table buiid
i |p
BOb table text height: 0125
™ Dawn
Balloon text height:
— Install Carner
BOM table rows limit:  Leit
Balloon size: 0.3125 &+ Right
Balloan Shape m ~Balloon ID—————————
@) Humerical
— Optior Lgd =
= | Bosll it d ebaijted b BER | ballann — BellliEm
™ | B Bk Eatle fram ballan catirk & Global
I~ BOM Spans multiple drawings
" Pick
= | Gl @h (1] with ballmer
_ —BOM Table
™ | FormBE o e Blask attitutes
& ToDwg.
v Header [~ [ouble Line ¥ | Eived EFE g
¢~ ToFile DFE]
BOM table design | Layers | sl lﬁ
: Tab v
Apply | Some tile actions - not applicable, disabled. Cancel | Help |

Figure 2.4.1.2

NOTE

The Mech-Q BOM Configuration dialogue is common to other Mech-Q Ultilities, for
example:

e Mech-Q Piping

e Mech-Q Isometric Piping

e Mech-Q P&ID

e Mech-Q HVAC Ducting

Configuration instructions can also be used for BOM Configuration in the other Mech-Q
utilities.

Several configuration items in the configuration dialogue might be disabled — Either

because these items are not applicable to the current module or because some BOM
items were found existing in the current drawing.
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Set the Mech-Q BOM configuration items according to your choice:
e “BOM table row height” This sets the BOM table row height when
the Mech-Q Drawing Scale is set at 1:1
e “BOM table text height’ This sets the BOM table text height when
the Mech-Q Drawing Scale is set at 1:1
e “Balloon text height” The BOM balloon text height (when the
Mech-Q Drawing Scale is set at 1:1) is set in this field.
e “‘BOM table rows limit’ This specifies the number of BOM table
rows before a new table is build.
e “Balloon size” This sets the BOM balloon size when the Mech-Q
Drawing Scale is set at 1:1
You have a number of options for the “Balloon shape”: Circle, Double
circle, Hexagonal or Leader only.

BOM Table Build Options

You have control on how the BOM Table is build in your drawing. You can
select to send the BOM table to a File or it can be build in the Drawing
(Dwg). The “To File” option lets you export the BOM table to a file,
allowing you then to import the data to a spread sheet or database
program.

If you select the “To File” option — you can use the “CFG” tab to control the
type of data to export.

Data Export [to File] Configuration x|
~ Export to: ——————————— Data exported in plain text
. format cannot be imported
™ Mech-0 BOM Fils to a drawing uzsing Mech-0

BOM file import utility.

Thiz option is only applicable.
for BOM T able command.

Other Available Fields Exported Fields
_ <Ren | lgr =
ary
SI£E
DESCRIFTION
LEM b
T
RATIMNG v

I~ Include drawing number

OF. I Caticel |
Figure 2.4.1.3

If you select the “Mech-Q BOM File” mode, the exported data is in a
suitable format to be imported into your drawing by using the Mech-Q
“BOM Table” command.

When you select the “Plain Text File” mode, the data is exported in a
simple text format (Most suitable for importation into spread sheet or

47



database program). In this mode you can also control which BOM field you
like to export.

When you build the BOM Table in the current drawing (“Dwg” option) to
can build the table in the “Up” or “Down” and the insertion point can be
“Left” or “Right” extreme point of the table.

When selecting which piping objects you like to add to the BOM table —

select the “Global” option to select all piping object , alternatively, select
the “Pick” option if you wish to select which items to add to the BOM table.

Other Options

Most other options are disabled for the piping BOM — These are more
relevant to the Mech-Q “general” BOM Ultilities.

BOM Table Design

The BOM Table design is generally fixed for the piping program — however,
you are allowed to change the width of each BOM table column and the
text justification in each column. Use the “BOM table design” tab to modify
the table design.

NOTE

The “Apply” tab will activate the BOM table building, adding of BOM balloons to your
drawing (if this option is selected) or send the BOM table data to file.
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m BOM Table in Current Drawing

After you have completed your piping drawing you can compile the piping
BOM table and build the BOM table to your current drawings.

NOTE

It is advisable that you set all BOM settings before any piping objects are added to the
drawing. Changing BOM setting after piping objects are already inserted might result in
program error.

At the start of the piping project it was decided that “Remarks” and “Stock
Codes” columns will not be required in the BOM table. These columns
were therefore disabled: => “Options” tab => “BOM CFG” tab =>
‘Remarks” and “Stock Codes” fields turned off.

NOTE

We recommend that you set the Mech-Q Drawing Scale equal to the DIMSCALE (From
the Mech-Q drop-down menu). Before you start adding the BOM table to the drawing
make sure that the DIMSCALE is set to the correct value to ensure that the BOM table is
build to the correct scale.

To start building the piping BOM table, use the “BOM” tab — piping main
dialogue. This will start the “Mech-Q BOM Configuration” dialogue. Set
the BOM settings as you prefer — but make sure that the BOM Table switch
is set “To Dwg”. For this exercise we have selected to set the Selection
switch to “Global”. We choose to set the table insertion point “Bottom” &
“‘Right”

Use the “Apply” tab when ready.

Command: Insertion point (Bottom right corner) for BOM Table:

The BOM table will then be build starting from the selected point.

NOTE

If you add or delete and Mech-Q piping objects you must run the BOM utility again. The
program will then detect the items changed and will build the new updated BOM with the
correct piping objects found in the drawing.
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Figure 2.4.2.1
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m Send BOM Table to File

After you have completed your piping drawing you can compile the piping
BOM table and export this in text format to a file.

NOTE

It is advisable that you set all BOM settings before any piping objects are added to the
drawing. Changing BOM setting after piping objects are already inserted might result in
program error.

At the start of the piping project it was decided that “Remarks” and “Stock
Codes” columns will not be required in the BOM table. These columns
were therefore disabled: => “Options” tab => “BOM CFG” tab =>
“‘Remarks” and “Stock Codes” fields turned off.

To start building the piping BOM table, use the “BOM” tab — piping main
dialogue. This will start the “Mech-Q BOM Configuration” dialogue. Set
the BOM settings as you prefer — but make sure that the BOM Table switch
is set “To File”. Then use the “CFG” tab

Data Export [to File] Configuration
~Expartte:———————————— Data exparted in plain bext
. format cantiot be imported
" Mech-0 BOM File to a drawing uzing Mech-Q

BOM file impart utility.

Thizs option is only applicable.
for BOM T able command.

[ther Available Fields Exported Fields

ITEM -
aTy —
SIZE

DESCRIPTION

LEM b
SPEC

RATIMG =

< Rem

S5

|

I~ Include drawing nurmber

(] I Cancel |

Figure 2.4.3.1

Set the Export to — “Plain Text File” All existing fields will be exported.
Then use the “OK” tab.

For this exercise we have selected to set the Selection switch to “Global”.
We choose to set the table insertion point “Bottom” & “Right”

Use the “Apply” tab (Mech-Q BOM CFG dialogue) when ready. This will
bring up the “Select BOM Data File” dialogue.
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Select BOM Data File

Writing BOH to file: PIPESPOOLZ.TXT

Cancel |

MNew file | Sppend | [iensmte |

Figure 2.4.3.2

You can accept the suggest (export) data file or use the “New File” tab to
select a new file name.

Select the “OK” tab when ready

AutoCAD Meszage Ed |

MECH-O:
BOR wiritten ta File: FipeSpool2, T=T

Figure 2.4.3.3

The BOM table will be written to the data file you selected.
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m Adding/Deleting Pipe or Fittings

NOTE
In this tutorial we will demonstrate how to add and delete pipe fittings.

x

F!'{
|
|
|
I
i

Figure 2.6.1

When editing any aspects of a drawing containing Mech-Q piping objects, it
is important to maintain the BOM integrity. You are allowed to use you use
AutoCAD’s editing command Stretch — However we do not recommend
that you use the editing commands Extend and Trim to lengthen or shorten
a piping component nor to use lines/Polylines to replace a pipe or fittings.

Instead we recommend that you follow the following procedures as a
guideline:

Deleting a Mech-Q pipe fitting
Refer to Figure 2.2.1

The flange between tags “D” and “F” is no longer required and must be
removed. The following steps are recommended:

e Use the AutoCAD command: Erase to remove the flanges.

e Also erase the two short pipe segments on either side of the flange.
(Pipe C-D: and F-G)

e Use the Mech-Q piping to draw a pipe of the required specification
from tag “C” to tag “G”
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Adding a Mech-Q pipe fitting
Refer to Figure 2.2.1

A “Butt Welded Valve” is required between tags “H” and “J”. The
following steps are recommended:

Use the Mech-Q piping and draw a butt-welded valve over the pipe
between tags “H” and “J” at the location required.

Use the AutoCAD command: Erase to remove the pipe between
segments “H” and “J”.

Use the Mech-Q piping to draw a pipe of the required specification
from tag “C” to tag “D”

U the Mech-Q piping to draw a pipe of the required specification
from tag “E” to tag “F”
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Chapter 3 Mech-Q HVAC Ducting

Mech-Q HVAC Ducting is a comprehensive ducting drafting package with
both 2D & 3D drawing modes capability. The software is also equipped
with auto-BOM functions and Flat-sheet development. The following
modules are included:

Straight Duct
Bends & Elbows
Transitions
Offsets

Tees & Wyes
Branches
Diffusers
Dampers
Accessories

Introduction

This tutorial will look at performing some tasks using the Mech-Q “HVAC
Ducting” module. The exercise will concentrate on drawing a simple
straight piece of duct followed by a 90° Bend, Flexible duct piece and a
Diffuser.

NOTE

The Mech-Q Duct Draw Utility (Straight Duct and Duct run module) starts the main control
dialogue of the Mech-Q HVAC Ducting module. Apart from drawing straight duct, straight
duct accessories & duct runs, it also controls and starts other Mech-Q HVAC Ducting
module functions, including:
e Bends configuration
Connection configuration
Layers configuration
Label & BOM options
Flat sheet development
Ducting symbols
Saving & changing the Ducting CFG’s
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Shape
{0 Rectang () Round ) Aat oval

Insulation
®Bt Ot OBoth OMNone  Thk

End Connection |P mode

End 1: None v| OTop
End 2: MNona v ® Cen
Intem None w O Bat

Size

Wid/Diam l:l Wall Ga 24 Connections CFG

Pressure Rating: l:l Class: g v Include tem in BOM

Draw View l Options ] | List/Edit ] [ Symbols ] | Savels ]

Sreigtuct Do) [loyes | [ Maich | [ Development | [ GeiCFG |
b ][] (]

Figure 3.1.0

Ducts can be drawn in three shapes:
e Rectangular
e Round
e Flat Oval
The duct shape is set from the “Shape” box.

You can add insulation (external, internal or both) to duct or duct fittings by
setting the “Insulation” box.

End connections can be: Flanges (Flat or Angle), or Male/Female
connection. Use the “Connections CFG” tab to start the connections
configuration editor

Connections can be specified individually for each end of duct or duct
fitting.

The duct size is specified:

“Wid/Diam (W)” edit box for Width (or Diameter - if round duct)

“Ht (H)” edit box for Height (Rectangular & Oval only)

The duct material wall gauge is specified in the “Wall Ga” list.

The Duct “Class” and “Pressure rating” (to be included in the BOM) can
also be specified

Various draw views (or duct accessories draw options) are available —
select the required view from the “Draw View” list.
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Duct Bends/Elbows CFG

The Bends configuration can be set in the “Duct Bends CFG” dialogue.
You can start the “Duct Bends CFG” dialogue via the “Bend CFG” tab in
the “Ducting Draw Utility” main dialogue:

Bendtype: | pitered v
Bends Corfiguration
Cuts  0-30deq: 2 "
Cuts 31-45deq: 3 “w
Cuts 46-60deg: 2 w
Cuts 61-90deq: g “w
Cuts 90+ deg: 7 w
Radius: |5] w I:I
Figure 3.1.1

NOTE

This setting in the “Duct Bends CFG” will determine the shape of bends generated by
using the Straight duct module — when the Draw View mode is “Run..” mode. When
drawing duct bends using the “Bends” module, the bend CFG is set from the “Bends
Draw” dialogue.

Various duct bend types are available and the type required is set in the
“‘Bend Type” list and includes:

e Mitred

o Radius

e Square Throat

For this exercise we will select a “Mitred” type bend. For Mitred type bends
you need to set the number of cuts according to the bend angle in the
“Bends Configuration” box.

The bend corner radius is set from the “Radius” list

Note: For the Square Throat type bends you can add Turning Vanes.
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m Duct Connection CFG

Available connection are:
e Flanges Flat
e Flanges Angle
e Male/Female (or collar overlap)
[ ]

None

Select the connection required from this connections list.  Other
connections details can beset by using the “Connections CFG” tab which

starts the “Duct Connections CFG” dialogue:
Duct Connections CFG El
Flange detail
Type (BOM Spec.) <MNones=
Flat type flanges
Flange thickness:
Flange width:

Angle type flanges

i|j
3
<

)
=
(%)

Select angle size:

mm

I

Gasket alloance (Angle flanges only):

Fasteners

Draw holes + centers CFG

Group flange with duct object

Male/Female overdap Extension

Length: Extension:

Connections at:

I

Ends only -

Figure 3.1.2

58



m Duct Draw Options

Use the “Options” tab to start the “Duct Draw Options” dialogue:

Duct Draw & BOM Options EJ
30 Options
[] Draw 3D
General Options
BOM/List/Dev - Active Draw centers
Int. Insulation: Increase Size I | Repect Draw
[ Hide/Trim crossing duct{2D) Hatch CFG
Label Options
Size label [ Top elevations
] Trim center round label [] Bottom elevations
[ Lebel/BevCFG ] [ Lengths Label

[ToKT] | cancel |

Figure 3.1.3.1

If you wish to draw 3D duct — set the “3D” toggle ON. In the 3D drawing
mode you can minimize the drawing database size by setting the “3D
Minimize Dbase” toggle ON — In this mode the duct internals are not
drawn and the duct is drawn as a solid.

In the 3D mode, the program will normally draw nodes (points) at the
common insertion points to assist you with manipulating the duct objects
and also to make it easier to insert other duct objects in the correct
location. If the nodes are not required turn the “IP Nodes” OFF.

To have the program add material details that is used by the program
auto-BOM, detail listing and development functions — make sure that the
toggle “BOM/List/Dev — Active” toggle is ON. Then drawing a BOM you
can specify that the program will add BOM balloons — this option is set by
selecting the “BOM Balloon” list choice that you require.

The program can add a duct “Size Label” and duct ends “Top Elevations”

— set the corresponding toggle according to your choice. The way text
(Labels & Elevations) are added to the drawing are determined by the
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settings in the “Label/Elevations Text CFG” dialogue. This is started by
selecting the “Label/Elev CFG” tab.

Label/Elevation Text CFG

Text height (&t scale 1:1):
Teat justification: MC .

Size/Elevation units: mm

Top Blevation Prefic:

=] _| (%]

Bottom Elevation Prefic:

[ Group label with object
aD: Auto-Calculate Elevations
[] Locate label

Figure 3.1.3.2
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2D Duct Draw Tutorial

NOTE

In this tutorial we will draw a simple ducting job 2D drawing mode, however the steps
required to draw the same ducting job in 3D format will be very similar...

The aim of this tutorial is to build simple ducting piece made up of a
straight piece of duct, duct bend (90° smooth radius elbow) joining another
short piece of straight duct, then a flexible duct turning 90° down and
terminating with a diffuser.

We have selected to draw our ducting job using metric units, however the
steps to draw the same job using English (imperial or inch) units will be
identical. To use the English units system — use the Mech-Q CFG and
change the “Units” to English.

Drawing a Straight Duct

Start the Mech-Q HVAC Duct Draw module

For this exercise we recommend that you select the settings/options as
follows

Type: Set the duct type “Round”.
Insulation: “Ext” (External), Thickness: 25mm
Wid/Diam: 200mm

Connections: “Flanges all ends”,

Thk: (Flanges Thickness) - 5mm
Use the “Connect CFG” tab set:

Type (BOM Spec): None

Flange width (F): 60mm

Holes edge dist, (E): 25mm

Holes diameter (D): 11mm

Number of Fasterers (W): 10

Connections at: “Ends only”

Use the “Bend CFG” tab to set:

Bend type: “‘Radius”
Radius: 100mm
Use the “Options” tab to set:
“3D: Off
“Draw Centres” On

“‘BOM/List/Dev — Active™.  On
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Draw View: “Straight Duct (Diam)”

NOTE

In more complicated jobs, we recommend that before you draw any duct or duct fittings
— start by drawing the ducting centreline (using normal AutoCAD commands) and at the
location of the duct fitting objects (Tees. Diffusers,...) — add a branch centreline or a
“dummy” node to locate the duct fittings.

Use the “Draw” tab to draw the first piece of straight duct.

Command: Starting Point:

Starting This is the starting point of the duct center.
Point:

Pick insertion point — starting point on duct center (= p1)

Command: To point(<point>/Length):

To Point:  Pick second point of the duct center to specify duct length by
two points.
Length: To specify the duct by entering the length of duct.

Enter “L”

Command: Length:

| Length: Enter the duct length.

Enter 1000.0

Command: Point direction.
Use the pointing devise to point a direction right of the duct starting point.

The duct , 1000mm long will now be drawn starting from p1. with flanges
at both ends and 25mm insulation.
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Draw Duct Elbow

Start the Mech-Q HVAC Bends & Elbows module:

Mech-Q Duct Draw Utility E

Bend type: Mitered v CFG
Shape
) Rect (& Round O Flat oval

Insulation

@Bt Oht OBcth ONone  Thic

End Connection

Size Options
Wid(W)/Diam: K End 1 None w
l:l End 2 None ~
Draw centers
I:l ] Repeat Draw Connections CFG ]
Tumed
raw View
W e 4 v S0deg Bend (Diam}) w
Fressurs Rating I:l Include item in BOM
i) () (=]
Figure 3.2.1

Accept the defaults as above. The duct settings will be carried over from
the settings used when the straight duct was drawn.

Set “Draw View” at: “90deg Bend (Diam)”
Use the “Draw” tab to start drawing a 900 elbow.

Command: Corner/Face IP(C/F)<C>:

Corner: Insertion point (IP) is the elbow corner point (intersecting
point of the elbow Centres)

Face: Insertion point (IP) is the face mid-point.

Enter: “F”

Command: Face Insertion point:
Pick insertion point — Right center point on duct drawn (above).

Command: Mirror (Yes/No) <N>

Accept the “No” option.

The Rotation dialogue will now be displayed:
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Rotation g|

50 deg

e toe | |

Figure 2.2.1.1

Select the rotation button = 90.0deg

The 90° elbow will now be drawn at the correct rotation with will 25mm
thick insulation.

Pick insertion point — Right centre point on duct drawn (above).

NOTE

In this exercise the length of duct and location of fittings (for example: Elbow) were not
critical. In most practical cases the location of elbows is important. In such cases we
recommend that the elbows (and other fittings) are drawn first (using the “Corner” IP
option) Straight duct will then be drawn last — from fitting to fitting.

Draw a Flange
(At elbow free end)

Start the Mech-Q HVAC Duct Draw module — Keep the default settings
Set “Draw View” - “Flange End View”

Use the “Draw” tab to draw the flange.

Command: Insertion Point:

Select the point center on the free face of elbow

The Rotation dialogue will now be displayed — Select the 90.0deg button

The flange will now be drawn at the correct rotation on elbow face.

Drawing a Short Piece of Straight Duct
(Starting from the free flange)

Start the Mech-Q HVAC Duct Draw module — Keep the default settings (as
above) except:
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Set “Draw View” - “Straight Duct (Diam)”
Connections: “No flanges/collar”
Use the “Draw” tab to draw the first piece of straight duct.

Command: Starting Point:

Starting This is the starting point of the duct center.
Point:

Pick insertion point — Outer mid-point of free flange (at end of elbow) = p1

Command: To point(<point>/Length):

To Point:  Pick second point of the duct center to specify duct length by
two points.
Length: To specify the duct by entering the length of duct.

Enter “L”

Command: Length:

| Length: Enter the duct length.

Enter 200.0

Command: Point direction.
Use the pointing devise to point a direction down of the duct starting point.

The duct will now be drawn, 200mm long, vertically down starting from p1.
with no flanges at either end will now be drawn.
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Drawing a Flexible duct

Start the Duct Accessories module:

Mech-Q DUCT - Accessories =3

2Ize

Size: [200
Flex. Spacings [0.25 |« Size
Flexible Duct w
Shape I:l
[ ]
Options Ends
2o []Single Line []90deg Bend - Start
[]Repeat Draw [150deq Bend - Finish
Gt | |
Include item in BOM [ P CFG ] [ llayers ]
[ omw | [BoW ) (W= ] [Ba] [ 5=k ]
Figure 3.2.2

Select the settings/options as follows

Type: “Flexible Duct”.
3D: Off

Single Line: Off

Label: On

Size: 200mm

Ends:

90Deg Bend-Start: Off
90Deg Bend-Finish: On

Use the “Draw” tab to draw the first piece of straight duct.

AutoCAD Meszage ]
bECH-G:

Pick points to define path of Flexible Duct

Figure 3.2.3
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The above AutoCAD message is for information only. The program allows
you to draw a flexible duct with multiple turning point. However for this
exercise we only require a short flexible duct from the end of the short
piece of straight duct to the diffuser entry.

Command: From Point(<point>/X to exit):

From This is the starting point of the flexible duct center.
Point:
X to exit X will terminate the program

Pick insertion point: mid-point — free end of short piece of straight duct (p1)

Command: To Point:

| To Point: The next point that describes the flexible duct path.

Pick the point: entry point of diffuser location (p2)

Command: To Point:

To Point:  The next point that describes the flexible duct path... If you
reply by an <enter> (No selection point) — the program will
assume that you have reached the flexible duct end point and
will draw the flexible duct termination end.

Enter with no point selection.

The flexible duct will be drawn from point p1 to point p2, a 90° down turn
drawn at point p2 (at Diffuser entry point)
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Drawing a Diffuser

Start the Duct Diffusers module:

Mech-Q Duct - Diffusers Utility

Size/Rating
Duct size: 200
Diffuser Width{:
Diffuser Height{Y):
Type Direction
() Rnd-Rnd () Supply l:l
(%) Ract-And O Retum Wall Ga: 2w
() Rect-Rect O Bxhaust Pressurs Rating: l:l
O Plenum ST ETE Flow Fiste: B m 3/
Throw: AW v
View: Plan |» Mark: A -
Dew | [ Bom | [ Llayes | [ Mach | | B | [ Heo |
Figure 3.2.4
Select the settings/options as follows
Type: “Rect-Rnd” (Rectangular diffuser with a round entry)
Direction: “Supply”
Duct Size: 200mm

Diffuser Width(X): 400mm
Diffuser Height(Y): 400mm
View: “Plan”
3D: Off

The “Throw” specifies the supply flow direction — 4W = 4 ways (all sides)
Set the “Show throw arrows” toggle ON to show the throw arrows in the
drawing.

You can also add a “Mark” number for BOM identification

NOTE

New “Mark” identifications can be added by selecting the <Add New> item from the
“Mark” list.

The Diffuser “Flow Rate” can be specified — this will be included with the
diffuser identification label.

Use the “Draw” tab to draw the first piece of straight duct.
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Command: Insertion Point:

Select the point of the diffuser enter point (Flexible duct turned end point).
The diffuser will be drawn at this point.

The Rotation dialogue will now be displayed — Select the 0.0deg button

The flange will now be drawn at the correct rotation on elbow face.

Command: Annotation insertion <point>/(Enter or S to Skip):

Select the insertion point to draw the Annotation Label (or use the Skip
option to draw no label)

This concludes the duct drawing tutorial.
The software is also equipped with Auto-BOM. The procedure for
generating a ducting BOM is very similar to that described under the piping

tutorial (Section 2.4). To start the ducting auto-BOM use the “BOM” tab in
the Straight Ducting main dialogue.
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Chapter 4 Mech-Q Structural

Mech-Q Structural is a collection of modules dedicated for structural
engineering and drafting. The main modules include:

Steel Shapes & Beams

Stairs

Ladders

Hand Railing

Bracing

Frames

Beam to Beam & to Column connections

Beam design module

Plus several structural symbols & other structural detailing utilities

In this tutorial we will not cover all the modules — but only the Steel Shapes
& Beam module and the Stairs module. For more details not covered in this
tutorial and details on how to use the other modules we recommend that
you refer to the Mech-Q Users Manual.

m Mech-Q Standard Steel Shapes and Beams

Mech-Q Standard Steel Shapes and Beams drawing utility draws steel
sections: profiles, end and plan views — in 2D mode and 3D drawing mode.
The utility is equipped with auto-BOM facilities.

Standard sections supported include:

Metric

Australian (BHP):

UB, UC, PFC, EA & UA and RHS
Canadian (CISC):

W, WWF, S, M, HP, C, MC, L and HSS
European (DIN):

INP & IPE, HEA & HEB, UNP & UPE, LE & LU, RHS
British Standard (BS):

UB, UC, Channels, Angles & RHS
South African (RSA):

I, H, Channels, Angles & RHS
Japanese (JIS):

I, H, Channels, Angles & RHS

Indian (IS):

I, H, Channels, Angles & RHS
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English
US: AISC/ASTM:

S, W, WT, M, HP, C, L - Eq & Uneq and RHS

Start the Mech-Q Standard Steel Shapes and Beams module from the
Mech-Q drop-down menu: Structural -

Structural toolbar:

[~ Convert Metiic -> English

Select Section Spec/Size:

r

“Sections Draw” or from the

|BHP [m] =| |410UBED
Drraw Optiohs
[~ Draw 3D

[~ Curved members

[ Plan wiew only

LCFG Layers |

Select View/Draw. . |

[=]

Australian BHP

UB-Section

Section Depth = 406.0 mm
Section Width = 178.0 mm
Flange Thick. = 12.8 mm
“Web Thicknesz = 7.8 mm

Unit mazz = 59.7 kgdm

E xit Help

Figure 4.1.1

Draw Options

The options for the Steel Shapes module include:

"Draw 3D”: Set the toggle ON to draw in 3D mode .

"Curved members": Set the toggle ON to draw curved beams.

“‘Plan view only”: When this toggle is set ON, the program bypasses the
Sections View Dialogue and starts drawing the selected steel member in
plan view. This option is useful in speeding up steel beam drawing if
several members are being drawn in plan view.



For the scope of this tutorial all the above options will the set off — We will
only look at 2D straight members.

@ Configuration (Draw CFG)

Select the “CFG” tab to start the “Structural Sections — Draw CFG”

dialogue:
Structural Sections - Draw CFG E]

Options

BOM On

[] Zero fillet

[] Add Centroid
[] Bepeat Draw
Lse pohiines

Annotation

[] Auto-Annotate CFG

Figure 4.1.2.1

NOTE

The Mech-Q Steel Shapes module is equipped with Auto-BOM features. BOM data is
only added to the Steel members when the BOM On toggle is set ON. If the BOM On
toggle is set Off — BOM features are disabled and no BOM data is added to the steel

members.

For the scope of the following tutorials — Make sure that the “BOM On”
toggle is set ON

Other Options include:

Zero Fillet: To draw steel shape sections with a zero fillet at corners.
Add Centroid: To add centre lines to beams and steel shape sections
Repeat draw: To draw several sections/beams of same size.

Use polylines: (Default selection) to draw all members using polylines
rather than lines.
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When the “Auto-Annotate” option is ON - Steel member size will be
added to member at the selected point.

The “CFG” button allows you to have predetermined “Prefix” and/or
“Suffix” added to the BOM size description in the BOM:

Structural Sections - Annotation CFG

%]

Tupe Prefix Suffix

HH-BEAM [ s [ ]
HW-BEAM [ ] s= [ ]
Channel |:| Size |:|
ER Angle [ ] s= [ ]
Ua Anale [ ] se= [ ]
Hollow Section |:| Size |:|
Str.Pipe [ ] s= [ ]

Include Standard Designation with Annotation

Teat height:
| oKk | | cancal
Figure 4.1.2.2
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m Steel Members - Layers

Mech-0 Structural Layers E|

M ame Calar Linetype

Str [Main] Layer b | |W| ¥ | . M' ¥ |
Symbalz Layer b | ISYM—| ¥ | Im ¥ |
Text Layer * | IWI » | Im
Text [Lrg) Layer * | |W| » | . Im
Dimengions Layer * | IDIM—| » | Im b |

St

St

Centers Layer > | [cenTER > | [pceposomew] > |
Hidden Layer > | [HIDDEN > | B poeoosaozw] > |
Options
* Buylayer " ByEntity
Prefix to Layer Mame: None = [ Draw on Curent Layer
Cancel
Figure 2.1.2

NOTE

The Mech-Q Structural Utilities use their own layers system and the layers setting in the
structural module overrides the layers setting in the general Mech-Q Configuration

Task 1:
Changing the Str Main Layer name to “Structural” Blue and Continuous.

Start the Structural layers configuration dialogue by selecting the “Layers”
tab — Steel Shapes main dialogue (or via any other Structural module
dialogue).

To change the Str (Main) Layer specification, follow these steps:

In the “Name” column, “Str (Main) Layer” row edit box enter the new layer
name “Structural”. If the “Structural” layer name is already defined in the

current drawing, use the "2 tab to select the layer name “Structural” from
the layer list.

Use the “# tab next in the “Color” column, then select the color “Blue” or
color number 5.
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In the “Linetype” column, edit box enter “CONTINUOUS” or use the =
tab to select the required linetype from the linetypes loaded in the current
drawing. If you enter a linetype in the “Linetype” edit box that is not yet
loaded in the drawing — Mech-Q will attempt to load this linetype if the
specified linetype is defined in the ACAD.LIN file.

This procedure will now define the “Str (Main) Layer” name = “Structural”,
Color = “Blue” and Linetype = “CONTINUOUS”.

Repeat the above procedure if you wish to change any other layer
configuration.

m Drawing Steel Members — Tutorial

For this exercise we will draw
a) A Steel Section: British Standard “H” member:
203x203x71
b) Two beams in plan view:
One “H” shape size: 203x203x71, Length = 2m and
One “Channel” size: 230x90, Length = 2.5m

a) Drawing a steel shape — in section view

Figure 4.1.3.1
Start the Mech-Q Standard Steel Shapes and Beams module (see
section 4.1)
Start by selecting the “H” shape — Second Icon, top row.

Under “Select Section Spec/Size” = Select “BS” (British Standard) and
size = 20x203x71

Note: The Detail window will list the steel shape details as selected.
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Use the “Select View/Draw” tab to start drawing the selected shape.... This will
start the “Select View to Draw” dialogue

NOTE

Image icons with multiple insertion marks “X” are sensitive to the pick position. When
drawing - make sure that you pick the image — close to the “X” insertion mark that best
suites your insertion point requirement.

To draw the steel shape (BS 20x203x71) — you need to select the top left
hand icon — This will close the dialogue and prompts you for:

Command: Install point (<point>/X to eXit):

Point: Select the insertion point (corresponding to the “X” mark on
dialogue icon) — in your drawing where you wish to install the
steel shape in section view.

X Will terminate the program.

Command: Rotation

Enter rotation value in degrees to rotate the steel shape — or
point with mouse to specify rotation.

If “Auto-Annotation” is ON

Command: Annotation insertion <point>/(Enter or S to Skip):

Point: Select the annotation (shape size) — insertion point in your
drawing. — No point selection will force program to skip
insertion the annotation

S Will force program to skip insertion the annotation

Command: Text Rotation

Enter rotation value in degrees to rotate the annotation text —
or point with mouse to specify rotation.
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a) Drawing Two beams — in Plan view

20320347

200x530x30

Figure 4.1.3.2

One “H” shape size: 203x203x71, Length = 2m and One “Channel” size:
230x90, Length = 2.5m

Start the Mech-Q Standard Steel Shapes and Beams module (see
section 4.1)

Start by selecting the “H” shape — Second Icon, top row.

Under “Select Section Spec/Size” = Select “BS” (British Standard) and
size = 203x203x71

Use the “Select View/Draw” tab to start drawing the selected shape.... This will
start the “Select View to Draw” dialogue

To draw the Plan view — select the icon — second from top — Pick the icon
at the left end...

The “Select View/Draw” dialogue will now disappear and the program will prompt
you:

Command: Install point (<point>/X to eXit):

Point: Select the insertion point (Left Point) — in your drawing where
you wish to install the steel beam in plan view.
X Will terminate the program.

Command: To point (<point>/Length):

Point: Select a point (right point) that represents the length of beam
relative to insertion point selected previously.
Length Select this option to Enter a beam length
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With the “Length” option — enter the length at 2000 (metric version =
2000mm)

Command: Rotation

Enter rotation value in degrees 0.0 — or point with mouse to
specify rotation — 0,0 direction.

The Steel Beam: 203x203x71 will be now drawn in plan view - 2000mm
long.

Start the Mech-Q Standard Steel Shapes and Beams module again.

Now selecting the “Channel” shape — Third Icon, top row.

Under “Select Section Spec/Size” = Select “BS” (British Standard) and
size = 230x90

Use the “Select View/Draw” tab to start drawing the selected shape.... This will
start the “Select View to Draw” dialogue

To draw the Plan view — select the icon — second from top — Pick the icon
at the left end...

The “Select View/Draw” dialogue will now disappear and the program will prompt
you:

Command: Install point (<point>/X to eXit):

Point: Select the insertion point (Left Point) — in your drawing where
you wish to install the steel beam in plan view.
X Will terminate the program.

Command: To point (<point>/Length):

Point: Select a point (right point) that represents the length of beam
relative to insertion point selected previously.
Length Select this option to Enter a beam length
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With the “Length” option — enter the length at 2500 (metric version =
2500mm)

Command: Rotation

Enter rotation value in degrees 0,0 — or point with mouse to
specify rotation — 0,0 direction.

The Steel Beam: 230x90 Channel will be now drawn in plan view
2500mm long.

Steel Members BOM - Tutorial

Use the drawing from tutorial 4.1.3 to generate a Bill Of Material (BOM) for
the two beams drawn.

Start the Mech-Q Standard Steel Shapes and Beams module again.

Use the “BOM” to start the “Steel Sections: BOM CFG” dialogue.

X]

Steel Sections: BOM CFG

Members Listing Length Units
{1 One ftem./Member ®m ymm
(®)Accumulate (same Size) -

Precision 1 "

() Accumulate {same Size+Len)

Include Plates

Include RMD and 5CQ Bars []BOM Balloons

[ Fields CFG | Next tem No-

| DegoMm | [ TomoOny |

Figure 4.1.4.1

You can select the default selection as above (Fig: 4.1.4.1).
Options to change include:
e Member listing (one item per member; Accumulated (if same size)
or Accumulated (if same size and length)
e Length Units (Ft, m or mm)
e Length/Weight calculation precision
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e With the One Item/member option — BOM Balloons can be added

e Remarks Option.

e Option to include Plates and/or Round and Square Bars (generated
by other Mech-Q modules)

Note: Field description and configuration can be changed by using the
“Field CFG” tab... this will start the “Steel Sections: BOM Fields CFG”
dialogue:

Steel Sections: BOM Fields CFG g|
Column Heading Lenath Pos  Inc
ITEM field: [ITEM | [180 | [ ]

Quantty field: [aty | [12o |

Designation field: |MEMBEH DESIGNATION | &0.0 |

Material field: MATERIAL | [0 | Ol
Length field: |LENGTH | [s0.0 |
Weight(Ka)field: ~ [WEIGHT | o ] B ]
Weight(Lb} field: [WEIGHT | oo ]
Part Numberfield:  [PART No | [ | ] O
Remarks field: [REMARKS | |50 | Ol

Pos = Column posttion, Inc = Include field

Row height:
Teat height:
[Tok] | cencel |

Figure 4.1.4.1

Heading = The BOM heading for each item

Length = Column Field width

Pos = Column position in the BOM table

Inc: Some items can be included/not included in the BOM table

Select the “OK” tab to accept the default selection (or change if required)
Use the “Apply” tab to start the BOM compiling process....Mech-Q will now

prompt you:

Command: Select objects

Select the Mech-Q Steel member objects that you want to be
included in the BOM table
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Command: Pick BOM table insertion point (Top right corner):

Pick the insertion point for the BOM table: Top right corner
point.

Mech-Q will now draw the BOM table starting from the selected point:

MEMBER DESIGNATION LENGTH/AREA (m/m”2) | WEIGHT [Kg]
UC 203x203x7" 2.0 142.0
PFC 230x90x32 2.5 B0.5

TOTAL W[T: 222.5

Figure 4.1.4.1
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M Mech-Q Stairs Drawing Tutorial

[ Draw 3D Stairs Width 900.0
View Options
. Dimension
) Front )
Add Handrail
O Plan Drraw hidden lines
) End Top landing ]
") Combined
Group ertities [ Degign CFG ]
Draw... | Eat | [ Detal. |
Figure 4.2.1

With this utility you can draw stairs: from Single-flight to multi-flight stairs.
Views include: Front, Plan and End. The module can also add the main
Dimensions and Stair Data if required. The Handrail outline can also be
added.

The module also allows you to draw the Stringer Detail with auto-
dimensioning ready for fabrication.

You can fully control the stairs design parameters, including stringer and
tread sizes, slope, width, stair flights configuration. However the stairs
configuration is controlled by recognized standard constraints to restrict the
drawing of unsafe stair design.

Start the Mech-Q Stairs module from the Mech-Q drop-down menu:
Structural - “Stairs” or from the Structural toolbar:
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The Stairs main dialogue (Fig: 4.2.1) allows you to:

Select the view to draw

Select to add auto-dimensioning

Add-Handrails

Draw hidden lines (or not)

¢ Add atop landing and to design the landing (“Landing CFG”)

The main stairs design parameters can be accessed by using the tab:
“‘Design CFG” tab and stringer detailing by using the “Detail...” tab

m Stair Design CFG

To start the “Mech-Q Stairs Draw Configuration” dialogue — use the
“‘Design CFG” tab

Mech-Q Stair Draw Configuration g]
o1 ' Db /]_ 0z
R
T e
‘]/ // ! Fa
Hz l//l "/ ﬂ Al

Ta EDIT: Click image within coresponding box

Dimension A = 120 Dimension B = 45
Dimension C = 18 Dimension G = 25
Dimension W = 380 Dimension D1 = 488
Dimension D2 = 380 Dimension DM = 1500
Dimension H1 = 484 Dimension H2 = 457
Max. Steps/Flight Defaults Fixed
[ | e LR
Max. Steps/Dirn I:I ® lle=d

f* M

W Risers Eq
Tread  [5ingle Lip w| Stinger  [poEgeiz
: Lavers | Cancel | Help |

Figure 4.2.1.1

NOTE

The icon image in the dialogue: Fig: 4.2.1.1 - represents a typical stair in front view. The
rectangular dimension boxes can be selected by the pointing device (e.g.: mouse) to
change the corresponding design value.

83



The list below the stairs image in Fig: 4.2.1.1 shows the stairs drawing
configuration as saved on disk.

You can change any of the parameters shown in the image with
rectangular boxed and the new data will be displayed in the list.

Example
To change the tread width “W” — click on the box marked “W”

Stair Design Configuration Editor @
wiidth of tread(w]:
Ok, | Cancel |

Suggested minimum tread widthla 271.5126
Figure 4.2.1.2

By entering a new value for “W” — for example 280.0 — the tread projected
width will now be drawn at 280.0 mm

Maximum number of steps in one single flight (without a platform) is set in
the “Max Steps/Flight” combo box. For this tutorial we have set this at 18

The Maximum number of steps without changing direction is set in the
“‘Max Steps/Dir’'n” combo box. For this tutorial we have set this at 36.

The program can calculate stairs in three (3) modes:
e Using a Fixed Slope (Stairs are drawn to a set slope (or angle)
e Using a fixed tread width
e Unfixed (none)

With the unfixed (“none”) option the program will work as follows:

The utility starts to calculate the required stair riser/tread relationship using
the default riser and default slope as set in the “Defaults” box. However, if
the calculated values do not fall within the values relationship specified by
set design standards, the slope is adjusted in infinitesimal values until an
acceptable riser/tread relationship is attained. The final riser and stair slope
differs slightly from the default values.

For the scope of this tutorial we have set the mode (“Fixed”) to “None”.

If you set the toggle: “Risers Eq” on — the program will make sure that all
risers are of equal height

Tread type can be selected from the “Tread” list — we selected “Single Lip”
for this tutorial
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Stringer material type (Flat bar or standard channel sections) can be
selected from the “Stringer” list. We have selected a C250x37 channel
section stringers for this tutorial.

m Stairs Draw - Layers

Layers can be set by using the “Layers” tab:

Mech-Q Structural L ayers E|
M ame Color Linetype

S MainjLayer > | [Stuctural > | [ Eavtmoans ] > |
Symbolz Layer ¥ | Sk ¥ | COMTINUOUS ¥ |
Test Layer > | e > | [conTmooos | > |
Text [Lra) Laver ¥ | TEXTZ ¥ |. COMTINUOUS ¥ |
Dimengions Layer ¥ | D ¥ |. COMTIMUOUS b |
Centers Layer > | [CEnTER > | [} poeossomew] > |
Hidden Layer > | [HIDDEN > | B eosonzw] > |

Optionz

e Buylayer " ByEntity
Prefix to Laper Mame: Im [ Draw on Current Laper

Cancel

Figure 4.2.2.1
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m Concrete Pan Treads

For this tutorial (Stairs Tutorial) we are using a “Single Lip” steel tread —
However you can select to use a Concrete Pan type tread as follows:

From the “Tread” list — select “Concrete Pan” — This will start the
“Concrete Pan Detail” dialogue:

Concrete Pan Detail

Fan depth [0
L Lip L)

O X C Lap (B]

L I Thickness [T]

Angle [A]

Select Design: i
g m 1zt step drop

wfidth [4/] =00.0 [ Backing strip
Tatal Depth [C) 2400 [v Draw Concrete

o
—
o =ENE
X

Cancel |

Figure 4.2.3.1

Concrete Pan Detail

X)

Ean depth (D)
JL | ome
b oK N it
© 0 omi
F oin
B W [FIt T hickness
1zt step drop

Select Design: Design 2~
Pitch Block: Hone -

Width [w] 240.0

[w Draw Concrete

Total Depth [C) 240.0

Cahcel |

Figure 4.2.3.2
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Two main types of designs are possible: Design1 (Fig 4.2.3.1) or Design2
(Fig 4.2.3.2) — as shown above. You can change from one design to
another by selecting the design from the “Select Design” list. When the
design is selected — set the design parameters in the respective dialogue
(as shown above) as required for your design.

For this tutorial — use the “Cancel” tab — then select “Single Lip” type
treads.

m Stairs Drawing Tutorial

The object of this tutorial is to add a stairs from Top of structure: point “A”
(Fig: 4.2.4.1) to the lower lever: point “B”.

(Note: Height A — B = 2500mm)

A

Figure 4.2.4.1

Start the Mech-Q Stairs module (see item 4.2)

For this exercise we will not add dimensions — therefore turn the
“‘Dimensions” toggle: Off. Other options and configuration setting we will
use the default settings (and as changed above).

We will draw the stairs in “Front” view — therefore select the “Front” view
option.
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To start the stairs drawing use the “Draw” tab.

Command: Stair top I.P.:

Select the insertion point (Stairs top-point) — Point “A” — top of
structure

Command: Point close to bottom I.P.(H for specified height):

Select the bottom point (Stairs bottom-point) — Point near
point “B” — bottom of structure

Note: If the “H” option is selected — The total stairs height can
be entered (2500mm for this example)

Mech-Q will now report that the “Total Number of Steps = 13" :

Mech-Q) Message

Total Mumber af Stepz = 13

Dezign...

Figure 4.2.4.2

Note: The “Design” tab can be use to alter the design of the stairs from
default design... If this option is selected, Mech-Q will start the “Multi-
Flight Stairs Design” dialogue:
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Multi-Flight Stair Design E3

Owerall width of stairs: 23220
Space betweeen flights 2300
Stair Top
Flight - 13
g Flight-
Landing
<-Flight
Stair Base
Total Mumber of Steps = 13
Steps Required 13
Edit Delete
Cancel Clear | Suggest |
Figure 4.2.4.3

This dialogue will allow you to add landings where required and change direction and
height of each stairs flight.

For this tutorial — we will not change the default design. When you Select
the “OK” tab — Mech-Q will draw the stairs between point A and B
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Figure 4.2.4.4

m Stringer Detailing Tutorial

Mech-Q can also dimension (detail) the stairs stringer as follows:

NOTE

The stairs stringer detailing function can only be used after the stairs is added to the
current drawing

Start the Mech-Q Stairs module.
Use the “Detail” tab to start the stairs stringer detailing function.

Command: Select STAIRS STRINGER

| Use your mouse and pick the stairs stringer
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Command: Insertion Point:

Select a point in your drawing where you wish the stringer
details to be added.

12 TREAD: B 2480 = 2224

128

JL%JS‘ERS @ 1923 = 2308

20

192

M
5
45

- 3l 120

Figure 4.2.4.5

NOTE

Mech-Q will use your current dimensions style to add dimensions to the stairs stringer as
above. If the dimensions do not look the way you expect — please adjust the dimension
style as you need — then repeat the stairs stringer detailing.
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Chapter 5 General Items

The following items are of general use in most Mech-Q Utilities.

m Mech-Q Grouping and Ungrouping

Groups

Mech-Q pipe fittings are drawn as a group of smaller sub components;
these smaller components can be edited separately for the purposes of the
user.

When groups are toggle ON, each Mech-Q pipe component is treated as a
single entity and when a selection is made, the full pipe component is
selected.

When groups are toggled OFF, each Mech-Q component breaks into
smaller individual sub components consisting of lines, fillets, etc.

Activating/Deactivating groups

In the “Tools” menu select “Options”. The “Options” dialog box will appear.
Select the “Selection” tab.

“Object Grouping” toggle ON: Mech-Q’s default, groups are ON, toggle
OFF will deactivate grouping.

1. Type “pickstyle” in the command window at the bottom of the screen.
You will be prompted for a new value for “PICKSTYLE” where the default is
<1>. Enter “1” to turn “Object grouping” ON or enter “0” to turn “Object
grouping” OFF.

2. Type “Ctrl A” to turn object grouping ON or OFF, the new setting will

appear in the command window at the bottom of the screen with either
<Group on> or <Group Off>.
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